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List of Abbreviations

Acq. acquisition
AIM Acoustic Influence Map
AOD axial outside diameter
AWS American Welding Society
BP band pass
COD circumferential outside diameter
CSC curved-surface correction
DAC distance-amplitude correction
DC direct current
DGS distance gain size
DHCP Dynamic Host Configuration Protocol
DNS Domain Name System
ERS equivalent reflector size
FBH flat-bottom hole
FMC full matrix capture
FSH full-screen height
FW full wave
HAZ heat affected zone
HAZ heat-affected zone
HP high pass
HW- half wave negative
HW+ half wave positive
IP Internet protocol
L Velocity longitudinal velocity
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LED light-emitting diode
ML material loss
ND no detection (of signal)
NS no synchronization
P/C pitch-catch
P/E pulse-echo
PA phased array
PCI phase coherence Imaging
PRF pulse repetition frequency
pts/λL points per wavelenght for longitudinal wave
pts/λT points per wavelength for transversal wave
PW pulse-width
PWI plane wave imaging
RCS Remote Collaboration Service
RF radio frequency
RGD red, green, blue
SDH side-drilled hole
T Velocity transversal velocity
TCG time-corrected gain
TFM total focusing method
USB Universal Serial Bus
UT ultrasonic testing
VPA virtual probe aperture
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Important Information — Please Read Before Use

Intended Use

The OmniScan MXU software is for the OmniScan X3 flaw detector, which is used in 
nondestructive inspections on industrial and commercial materials.

 
Do not use the OmniScan X3 flaw detector for any purpose other than its intended 
use. It must never be used to inspect or examine human or animal body parts.

Instruction Manual

This instruction manual contains essential information on how to use this product 
safely and effectively. Before using this product, thoroughly review this instruction 
manual. Use the product as instructed.

Keep this instruction manual in a safe, accessible location.

WARNING
Important Information — Please Read Before Use 11
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Some of the details of components and software images in this manual may differ 
from your instrument’s components or software display. However, the principles 
remain the same.

Instrument Compatibility

Always use equipment and accessories that meet Evident specifications. Using 
incompatible equipment could cause equipment malfunction and/or damage, or 
human injury.

Safety Symbols

The following safety symbols might appear on the instrument and in the instruction 
manual:

 General warning symbol
This symbol is used to alert the user to potential hazards. All safety messages that 
follow this symbol shall be obeyed to avoid possible harm or material damage.

 Shock hazard caution symbol
This symbol is used to alert the user to potential electric shock hazards. All safety 
messages that follow this symbol shall be obeyed to avoid possible harm.

IMPORTANT

CAUTION
Important Information — Please Read Before Use12
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Safety Signal Words

The following safety signal word might appear in the documentation of the 
instrument:

The CAUTION signal word indicates a potentially hazardous situation. It calls 
attention to a procedure, practice, or the like that if not correctly performed or 
adhered to may result in minor or moderate personal injury, material damage, 
particularly to the product, destruction of part or all of the product, or loss of data. Do 
not proceed beyond a CAUTION signal word until the indicated conditions are fully 
understood and met.

Note Signal Words

The following note signal words could appear in the documentation of the 
instrument:

The IMPORTANT signal word calls attention to a note that provides information that 
is important or essential to the completion of a task.

The NOTE signal word calls attention to an operating procedure, practice, or the like, 
that requires special attention. A note also denotes related parenthetical information 
that is useful, but not imperative.

The TIP signal word calls attention to a type of note that helps you apply the 
techniques and procedures described in the manual to your specific needs, or that 
provides hints on how to effectively use the capabilities of the product.

CAUTION

IMPORTANT

NOTE

TIP
Important Information — Please Read Before Use 13
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Safety

Before turning on the instrument, verify that the correct safety precautions have been 
taken (see the following warnings). In addition, note the external markings on the 
instrument, which are described under “Safety Symbols.”

Warnings

General Warnings

• Carefully read the instructions contained in this instruction manual and in the 
OmniScan X3 User’s Manual prior to turning on the instrument.

• Keep this instruction manual in a safe place for further reference.
• Follow the installation and operation procedures.
• It is imperative to respect the safety warnings on the instrument and in the 

instruction manuals.
• If the equipment is used in a manner not specified by the manufacturer, the 

protection provided by the equipment could be impaired.

Warranty Information

Evident guarantees your Evident product to be free from defects in materials and 
workmanship for a specific period, and in accordance with conditions specified in the 
Evident Terms and Conditions available at https://evidentscientific.com/evident-terms/.

The Evident warranty only covers equipment that has been used in a proper manner, 
as described in this instruction manual, and that has not been subjected to excessive 
abuse, attempted unauthorized repair, or modification.

Inspect materials thoroughly on receipt for evidence of external or internal damage 
that might have occurred during shipment. Immediately notify the carrier making the 
delivery of any damage, because the carrier is normally liable for damage during 

WARNING
Important Information — Please Read Before Use14
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shipment. Retain packing materials, waybills, and other shipping documentation 
needed in order to file a damage claim. After notifying the carrier, contact Evident for 
assistance with the damage claim and equipment replacement, if necessary.

This instruction manual explains the proper operation of your product. The 
information contained herein is intended solely as a teaching aid, and shall not be 
used in any particular application without independent testing and/or verification by 
the operator or the supervisor. Such independent verification of procedures becomes 
increasingly important as the criticality of the application increases. For this reason, 
Evident makes no warranty, expressed or implied, that the techniques, examples, or 
procedures described herein are consistent with industry standards, nor that they 
meet the requirements of any particular application.

Evident reserves the right to modify any product without incurring the responsibility 
for modifying previously manufactured products.

Technical Support

Evident is firmly committed to providing the highest level of customer service and 
product support. If you experience any difficulties when using our product, or if it 
fails to operate as described in the documentation, first consult the user’s manual, and 
then, if you are still in need of assistance, contact our After-Sales Service. To locate the 
nearest service center, visit the Service Centers page on the Evident Scientific Web site 
https://www.evidentscientific.com/service-and-support/service-centers/.
Important Information — Please Read Before Use 15
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Introduction

The OmniScan MXU software runs on the innovative, portable OmniScan X3 flaw 
detector. Its ultrasonic inspection functions make it suitable for numerous 
nondestructive testing applications. The software combines conventional ultrasonic 
testing (UT), phased array (PA), and total focusing method (TFM) operation modes.

In addition to this document, the following documents are relevant to the 
OmniScan X3 flaw detector operation:

OmniScan X3 — User’s Manual 
Provides a detailed description of the OmniScan X3 flaw detector. Refer to this 
document for operating instructions, maintenance, connections, specifications, 
and typical accessories.

OmniScan X3 — Getting Started Guide
A short leaflet containing essential information on how to quickly start operating 
the OmniScan X3 flaw detector.
Introduction 17
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1. Instrument Overview

The OmniScan X3 flaw detector features front panel controls for easy and efficient 
operation of the OmniScan MXU software. Figure 1-1 on page 20 shows the 
OmniScan X3 front panel and the available controls and indicators.

In this document, hardware controls that you press to activate are referred to as keys. 
The term button is reserved for software controls.

NOTE
Instrument Overview 19
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Figure 1-1  Front panel controls of the OmniScan X3 flaw detector

Table 1  Front control panel controls description 

Item 
number Description

1 Display touch screen

2 Alarm indicator lights

3 Help key

4 Main controls: Accept key, Cancel key, and scroll 
knob

5 Zoom key

6 Play key

7 Pause key

8 Save key

① ②

③

④

⑤

⑥

⑧

⑦

⑨

⑩⑪
Chapter 120
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1.1 Turning On and Off the OmniScan X3

This section explains how to turn on and off the OmniScan X3 flaw detector. The 
OmniScan MXU software shuts down automatically when you turn off the 
OmniScan X3 flaw detector.

To turn on the OmniScan X3

1. Press and hold the Power key () for one second.
The system starts up, performs a memory check, and the launch screen appears 
(see Figure 1-2 on page 22).

If the system encounters a problem during the start-up phase, the power indicator 
light indicates the nature of the problem using a color code (for details, refer to the 
OmniScan X3 User’s Manual).

9 Power key

10 Power indicator key

11 Acquisition indicator light

Table 1  Front control panel controls description (continued)

Item 
number Description

NOTE
Instrument Overview 21
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Figure 1-2  OmniScan Launcher

2. Tap to start the desired application and/or to configure the following:
— OmniScan Launcher (applications)—if more than one application is 

available. The compatible file type has the .wrp file extension.

—  OMNISCAN X3 (hard drive)—a series of buttons appears on the screen. 
To delete an application, tap and hold it until a message confirms the 
deletion. Applications must be on the hard drive to be executed.

—  REMOVABLE DRIVE—displayed only if a USB key or SD card is 
connected. Tap on an application to transfer it to the hard drive.

Prior to use, format the removable drives to one of the supported file systems, NTFS 
or exFAT. 

—  CLOUD—displayed only if the  CLOUD CONNECT is configured. This 
option gives you access to the official version of the system (MXU, System 
Update and Probe_Wedge Update). Tap on an application to transfer it to the 
hard drive.

—  WIRELESS—To activate the  WIRELESS function, you need to plug 
the wireless LAN dongle into the instrument and, in the Wireless Properties, 

IMPORTANT
Chapter 122
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check the Wireless Enabled option and select and configure your wireless 
Internet network.

—  CLOUD CONNECT—To activate  CLOUD CONNECT, you must 
enable the  WIRELESS function. Tap  CLOUD CONNECT, check 
Enable in the Cloud Settings, and make sure that the Ready and Enable 
statuses are Yes.

— —The information button shows the installed versions of the Platform 
Compatibility, Low Level, and System. 

— AUTO-BOOT—Toggle this to ON to set the OmniScan X3 flaw detector to 
automatically boot up using the selected application (OmniScan X.X) on 
subsequent start-ups.

— Language—This option enables you to change the language of the software. 
You must change the language before starting the application.

— Keyboard Layout —This option enables you to change the keyboard 
language of the software. You must change the keyboard language before 
starting the application.

If you always choose the same application, you can skip the application selection 
step for future restarts by selecting Always boot the selected application below 
the software buttons.
To regain the ability to choose the application at start-up, select  Preferences > 
System, and then Manual boot.

To turn off the OmniScan X3

1. Press and hold the Power key () for 3 seconds.
2. Tap the Shut Down button on the confirmation window to turn off the 

OmniScan X3 flaw detector.

If the OmniScan X3 does not react after a short press of the Power key () (or after 
selecting Shut Down), press and hold the Power key () for at least five seconds. 
This initiates a power-down sequence. However, your setup will NOT be saved with 
this method.

IMPORTANT
Instrument Overview 23
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Never attempt to turn off the OmniScan X3 flaw detector by removing all power 
sources, because this could cause a faulty start-up the next time you turn it on.

1.2 Installing Software

The OmniScan MXU software can easily be updated. You can download the latest 
MXU software version at: https://www.olympus-ims.com/en/service-and-
support/downloads/ or by using the  CLOUD option. From the Internet, extract the 
contents of the *.zip file on a USB key or SD card, and then insert it into the 
OmniScan X3 instrument. The file needs to be on the root directory of the removable 
drive to be detected. From the  CLOUD, select the application to copy to the 
instrument. On the launcher screen, tap the inserted media folder and select the 
application to copy to the instrument. After the copying has been completed, the 
newly installed software appears in the OmniScan X3 main folder.

1.3 Main Controls

The three main controls shown in Table 2 on page 24 enable full operation of the 
OmniScan MXU software.

Table 2  Main controls for OmniScan X3 flaw detector 

Image Name Description

 

Scroll 
knob

Rotate the scroll knob clockwise or counterclockwise 
to select a desired software button, or change a 
parameter value.

CAUTION
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1.4 Function Keys

The function keys are located on the keypad on the right side of the OmniScan X3 
front panel (see Figure 1-1 on page 20). Table 3 on page 25 summarizes how to use the 
function keys to activate different software functions.


Accept 

key
Press the Accept key to activate the current selection, 
and move to the next level in the menu hierarchy.
In an alphanumeric parameter value field, pressing 
the Accept key twice (or tapping the parameter twice) 
opens the software keyboard.

 


Cancel 

key
Press the Cancel key to cancel the current selection, 
and return to the previous level in the menu 
hierarchy.

Table 3  Key functions for OmniScan X3 flaw detector

Image Name Function

 


Zoom Used to enter and exit Zoom mode. For details, see “Using 

the Zoom, Pan, Gates, and Print Screen” on page 41.

 


Play Used to restart the inspection data acquisition, and/or the 

encoders, depending on the configuration on the  Scan > 
Inspection menu.

 


Pause Used to toggle between the inspection and analysis modes.

 


Save Used to save the report, data, or image, depending on the 

configuration on the File name menu.

Table 2  Main controls for OmniScan X3 flaw detector (continued)

Image Name Description
Instrument Overview 25
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1.5 Indicators

There are three types of LED indicators on the instrument front panel that turn on, off, 
and flash different colors (see Figure 1-1 on page 20): 

• Power LED—green if the instrument is “on”, but flashes red during a critical 
power situation. (Refer to the OmniScan X3 User’s Manual for full status 
descriptions, for example, orange states during charging.) 

• Acquisition LED—turns orange during analysis mode and off during inspection.
• Alarm LEDs (3)—turn red when an associated (gate) alarm is triggered.

1.6 File Formats

From MXU 5.11 and forward the file format used in the OmniScan X3 is the .nde file 
format rather than the legacy .odat format. 

Note that .nde is an open file format that allows data to be accessed with no 
proprietary software.

The .odat file format will still be supported in MXU versions 5.11 and up, but no new 
.odat files will be created. 

Set up files created before MXU 5.11 are supported. However, new data files will use 
the .nde format. If an .odat file is edited and saved using MXU 5.11 and up, it will 
remain in the .odat file format.

Added analysis features are not available for .odat files in MXU versions 5.11 and up.
NOTE
Chapter 126
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2. OmniScan Interface

The main components of the OmniScan MXU software user interface are shown in 
Figure 2-1 on page 27.

Figure 2-1  OmniScan MXU interface components

① ② ③ ④ ⑤ ⑥

⑧

⑦

⑨⑩⑪
OmniScan Interface 27
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In this manual, the OmniScan MXU software screen images are displayed using the 
default color scheme, which is designed for indoor use. However, an alternative color 
scheme is available for outdoor operations in version 5.1 (see “Preferences” on 
page 93).

2.1 OmniScan MXU Software Navigation

Figure 2-2 on page 29 shows the three menu levels of the OmniScan MXU software, 
and describes the syntax used throughout this manual to systematically select the 
menu and submenu, and to optionally enter or select a parameter value. For example, 

Table 4  OmniScan MXU interface components 

Item 
number Description

1 Main menu

2 File menu

3 Status indicator

4 Focal law groups menu

5 Layout menu

6 View menu

7 Scan position indicator and control

8 Index position indicator and control

9 Readings menu (scroll for more)

10 Ruler (scale)

11 Data screen

NOTE
Chapter 228
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 >  Gates & Alarms > Gate Main > Start signifies that you first select the Main 
menu, then  Gates & Alarms menu, followed by Gate Main submenu, and finally 
the Start parameter.

Figure 2-2  Menu hierarchy and identification syntax

The menu temporarily appears horizontally over the data screen area, with submenu 
selections to the right. When selected, the parameter submenu appears over the data 
screen. It is possible to scroll to another submenu using the arrow buttons (). The 
submenu can be hidden by tapping the close button (), or it can be pinned () to the 
side of the screen (see Figure 2-3 on page 30).

Menu > Submenu > Parameter value
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Figure 2-3  Scroll and reposition a parameter submenu

2.2 Gain

The Gain value applied to all focal laws of the current group appears in the upper-left 
corner of the screen. Figure 2-4 on page 30 shows the information displayed in the 
Gain value field.

Figure 2-4  Gain value field

The Gain value field presents two values after the  UT Settings > Advanced > 
Reference dB parameter is turned On (in TFM, Reference dB is turned on in 
TFM Settings > General). Setting Reference dB to On freezes the current gain value 

Scroll to another 
submenu

Tap pin to reposition

Gain units

Reference gain value
Adjustment gain
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as the reference gain. An adjustment gain value appears in order to show gain value 
changes. With an active reference, the gain applied to all focal laws is the total of the 
reference gain plus the adjustment gain.

2.3 Status Indicators

The current status of the OmniScan X3 flaw detector is indicated at the top of the 
screen (see Figure 2-5 on page 31). Table 5 on page 31 provides a list of the status 
indicators and their meanings.

Figure 2-5  Example of the status indicators

Table 5  Status indicators and their meanings 

Indicator Meaning

The number of data points on the inspected area exceeds the 
number of available pixels (see “Compression (TOFD Only)” on 
page 123).

High definition: Used to see the data scale and ruler on the 
instrument correctly with the resolution of the screen (1280 × 768). 
Seeing the HD icon tells you that there is no compression in the 
scan axis (in the case of one-line scans) or both the scan axis and 
index axis (in the case of raster scans).

TCG 
(green)

The time-corrected gain (TCG) is applied (“TCG/DAC Calibration” 
on page 170).

DAC 
(green)

The DAC curve is applied to the current group.

DGS 
(green)

The DGS curve is applied to the current group.

Calibration status Power status/battery charge/AC connection

C
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2.4 Battery Status Indicators

The battery status indicators at the top of the screen indicate the amount of power 
remaining in the batteries:

• The percentage of remaining power is displayed next to the indicators. The 
OmniScan X3 flaw detector must be turned on for approximately 15 minutes 
before it is able to accurately display this information.

• The bar length in the battery status indicator represents the approximate amount 
of power remaining in each battery (for example, 70% ).

The maximum ambient temperature for OmniScan X3 battery discharging is 45 °C 
(the maximum OmniScan X3 operating temperature).

Blinking: The GPS is acquiring the device’s location.
Steady: The geolocation is active and the position is acquired.

 [52]°C The OmniScan X3 flaw detector’s internal temperature in degrees 
Celsius.

 [ ] The wireless LAN is active.

Connected to the cloud (with notifications).

S (green) The sensitivity is calibrated. 

W (green) The wedge delay is calibrated. 

Table 5  Status indicators and their meanings (continued)

Indicator Meaning

④

IMPORTANT
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If you attempt to turn on the OmniScan X3 with one or two batteries that are too low 
for operation, the power indicator light blinks red rapidly for about three seconds. 
Replace the battery or batteries or plug in the DC power adaptor to operate the 
OmniScan X3 flaw detector.

Figure 2-6 on page 33 provides details about the variations of the battery charge 
indicator.

Figure 2-6  Battery indicator variations

The battery status indicator in MXU and the battery status indicator on the batteries 
may differ. This is because the OmniScan MXU software is more conservative with the 
remaining charge. Figure 2-7 on page 34 shows the equivalence between the software 
and hardware battery indicators.

NOTE

Missing or incorrectly installed battery

Fully charged (disconnected from the DC power adaptor)

Battery level (combined remaining charge percentage)
Level increments in 1 % steps (0–100 %)

Charging (interior blinking) with percentage of charge attained

Fully charged (connected to the DC power adaptor)

Too hot to charge

Too hot to operate, or critical temperature (rapid blinking)
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Figure 2-7  Battery charge display in MXU vs. hardware indicator

2.5 Data Screen

The data screen area displays the various ultrasonic data views and layouts.

Scans, Views, and Layouts

A scan is a 2-D graphical representation of ultrasonic data with a ruler or scale 
corresponding to the horizontal and vertical axis (see “Rulers/Scales” on page 120). 
For example, an A-scan and a C-scan are two different types of scans.

Software Hardware
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A view is a volumetric representation of a part, which includes signal overlays. Like a 
scan, a view has two axes. However, instead of being related to a specific group of 
ultrasonic probe beams that use the same parameters (also referred to as a “beam 
set”), a view is linked to the part. A signal that originates from a single group or from 
multiple groups can be displayed without affecting the view dimensions.

Table 6 on page 35 lists the basic ultrasonic scan views, which are illustrated in 
Figure 2-8 on page 36.

Table 6  Basic ultrasonic scan views 

View  Point of view Axis content

A-scan Looking down on the 
material

Amplitude versus ultrasound

B-scan Side Ultrasound versus scan

C-scan Top Scan versus index

S-scan End Ultrasound versus index
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Figure 2-8  Example of ultrasonic scan views

The scans and views, which are available on the Layout menu, can be further 
described as follows:

A-scan
The scan on which all other scans are based. An A-scan is a representation of the 
received ultrasonic pulse amplitude versus time-of-flight (ultrasound path), or a 
waveform. A peak in the signal corresponds to the echo of a reflector or a 
discontinuity in the part. In TFM, the A-scan is constructed from the TFM grid 
and is not generated by a single beam like in standard PA.

Top (C-scan) view

Side (B-scan) view
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B-scan (side view)
2-D side representation of the part, showing ultrasonic data with the scan length 
on one axis and the ultrasound path on the other axis.

C-scan (top view)
2-D top representation of the part, showing gated ultrasonic data with the scan 
length on one axis and the index length on the other axis. One of the available 
parameters (for example, the maximum amplitude) is projected on the index-scan 
plan for each point (pixel).

S-scan (PA group only)
2-D representation of ultrasonic data, presenting all the A-scans generated by the 
focal laws in an angular sector or sweep range in order to create a cross section of 
the part. The A-scans are represented by lines on which the amplitude is color-
coded, and they are corrected for delay and true depth so that their positions are 
accurate relative to the ultrasound axis.

End view (TFM group only)
2-D representation of the ultrasonic data acquired with TFM. This view displays 
the amplitude color-coded on an ultrasound-index plan. The size of each axis is 
defined by the Zone parameters. The view will be displayed according to the 
geometry of the part, so curved parts will be displayed on curved axes.

Top view (TFM group only)
2-D representation of ultrasonic data acquired with TFM. This view displays the 
maximum amplitude of the full ultrasound range on a scan-index plan.

Side view (TFM group only)
 2-D representation of ultrasonic data acquired with TFM. This view displays the 
maximum amplitude in a projection on the scan-ultrasound plan.

Your layout selection can combine the most useful views (see Figure 2-9 on page 38).
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Figure 2-9  Layout menu

To select a layout

1. Tap the Layout menu.
2. Select the layout(s) to be displayed.
3. To toggle between Single group layout or Multiple groups layout, tap the View 

button, and select either Single or Multiple.

When one group is displayed, the layout combinations can include the following 
views:

• A (A-scan)
• B (B-scan)
• C (C-scan)
• S (S-scan)
• End view (TFM group)
• Top view (TFM group)
• Side view (TFM group)

When multiple groups are displayed, combinations of the above-mentioned layouts 
are possible.
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Groups are displayed in the layout according to the actual scanner configuration and 
the offsets.

If you have a multiple group setup, you may want to rename the groups in the scan 
plan.

2.6 Using the Touch Screen

You can interact with the OmniScan MXU software using the touch screen, but, if you 
prefer, it is also possible to connect a mouse and/or a keyboard through the USB ports.

To use the touch screen

• Simply tap once on the touch screen to do a left click.
• Tap and hold your finger on the touch screen to do a right click. Many shortcuts 

(see Table 57 on page 125) are available using a tap and hold (or right-click).

Instead of using the virtual keyboard or numerical keypad, you can simply input 
values using a physical keyboard connected to the instrument.

In some cases, gate or cursor selection zones overlap. If you attempt to select a cursor 
or gate at the point where they overlap, they will be selected in this order of priority: 
Reference cursor, Measurement cursor, Data cursor, gate A, gate B, and gate I.

2.6.1 Entering or Editing Values

You can use the virtual keyboard, arrows, or scroll knob to enter or edit numerical 
parameter values.

NOTE

TIP

IMPORTANT
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To enter or edit values

1. Tap the parameter (see Figure 2-10 on page 40).
2. Rotate the scroll knob to change the value, and then press the Accept key ().

OR
Tap  to display the numerical keypad, then enter the value, and tap the Accept 
button ().
Alternatively to accept, press another key or button, or tap any layout view.

To revert to the previous value, press the Cancel key () on the instrument or the 
Cancel button () on the virtual keyboard.

You can display the numerical keypad by tapping twice on the numerical parameter 
you wish to change. Also, you can change the scroll knob increment using  and .

Figure 2-10  Parameter adjustment using up/down arrows or keypad

TIP
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2.6.2 Using the Zoom, Pan, Gates, and Print Screen

To use the zoom

1. Press the Zoom key () to turn on (or off) zoom mode (see Figure 2-11 on 
page 41).

2. Adjust the zoom:
 Tap the screen twice at the corners of the area you want to zoom.

OR
Press twice on the Zoom key to reset the zoom.
OR
Tap the view location you wish to zoom, and then use the scroll knob to create 
a concentric zoom that is centered on the tapped position.

Figure 2-11  Zoom example

To pan within a zoomed view

 Click on the ruler corresponding to the axis you want to pan. Either use the knob 
to pan the view, or input the center position of the window in the field Center.
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To adjust the gates

1. To adjust the gate Start, tap the left end of the gate.
2. To adjust the gate Threshold, tap the middle of the gate.
3. To adjust the gate Width, tap the right end of the gate.

When a gate is short, it might be impossible to tap a specific zone. In this case, gate 
Start and Width controls are almost at the same position on the screen. Use the Gate 
menu to adjust a gate if tapping a specific zone is too difficult (see Figure 2-12 on 
page 42).

Figure 2-12  Visual reference on the gate

To use Print Screen

 Press the Zoom key () to turn on zoom mode (see Figure 2-11 on page 41), and 
then tap Print Screen on the display.

NOTE
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After tapping Print Screen, you have two to three seconds to make any screen 
adjustments or to open any temporary menus before the screen image is taken.

2.6.3 Pop-Up Buttons and Menus

Some buttons or menus enable pop-ups; for example, for parameter values, file names 
or probe/wedge library items (see Figure 2-13 on page 43).

Figure 2-13  Pop-up menu example

2.7 Main Menu Organization

The Main menu provides a range of submenus for inspection configuration 
(see Figure 2-14 on page 44 and Table 7 on page 44).

NOTE
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Depending on your chosen configuration, the menu can change from  UT Settings 

to  TFM Settings.

Figure 2-14  Main menu

Table 7  Main menu options 

Menu Description

 Plan & Calibrate Use this menu to create a complete application setup. 
The Scan Plan and Calibration wizards guide you in 
creating your setup.

 UT Settings This menu contains the parameters regularly modified 
during inspection, such as the gain and pulser/receiver 
parameters. (Available only for PA/UT inspections.)

 TFM Settings This menu provides settings for the total focusing 
method and full matrix capture. (Available only for TFM 
inspections.)

NOTE
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2.7.1 UT Settings

The UT Settings menu enables you to access the General, Pulser, Receiver, Beam, 
and Advanced parameters.

2.7.1.1 General

Using the General parameter, you can see and modify the Start, Range, Wedge Delay, 
Velocity, UT Mode, and High Amplitude options. To access these options, go to UT 
Settings > General (see Figure 2-15 on page 46 and Table 8 on page 46).

 Gates & Alarms This menu contains parameters for configuring gates, 
alarms, and output signals.

 Scan Use this menu to set the parameters related to the 
scanning, such as encoders and the area to scan.

 Probe & Part Use this menu to define probes and wedges and to 
adjust the parameters related to the probe position or 
part thickness previously defined in the scan plan.

 Focal Laws Use this menu to adjust the parameters related to the 
focal laws originally defined with the Focal Law wizard.

Measurements This menu contains the parameters related to various 
measurement tools.

 Display This menu contains the parameters related to the data 
views and the information visible on the screen.

 Preferences Use this menu to set instrument configuration 
parameters when you start using the instrument. For 
example, the measurement unit (millimeters or inches) 
and the date and time.

Table 7  Main menu options (continued)

Menu Description
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Figure 2-15  UT Settings — General

2.7.1.2 Pulser

Using the Pulser parameter, you can see and modify the Select Pulser, Voltage, 
Frequency, Velocity, PW, Acq. Rate, and Interleave options. To access these options, 
go to UT Settings > Pulser (see Figure 2-16 on page 47 and Table 9 on page 47).

Table 8  UT Settings — General

Option Description

Start Used to set the starting location of the ultrasound axis 
(expressed in units of distance or time, according to the 
UT Mode setting.).

Range Used to set the length of the ultrasound axis (expressed 
in units of distance or time, according to the UT Mode 
setting).

Wedge Delay Used to set the delay applied to all focal laws in the 
group (expressed in µs (microseconds)).

Velocity Used to set the velocity of ultrasound in the material 
(expressed in m/s (meter per second) or in µs 
(microseconds)).

UT Mode UT: Used to change the ultrasound axis representation: 
Time, Sound Path, and True Depth. TOFD is set to 
Time and PA is set to True Depth in read-only.

High Amplitude Used to switch between 200 % and 800 % mode. Data is 
encoded on 16 bits, so 200 % yields more precision, 
while 800 % provides greater tolerance to high 
amplitude variations.
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Figure 2-16  UT Settings — Pulser

Table 9  UT Settings — Pulser 

Option Description

Select Pulser PA Connector: Displays the number of your starting 
pulser.
UT Connector: Displays P1 or P2 according to the 
connector defined in the scan plan.

Voltage PA Connector: Used to set the voltage of the pulser to 
either 40 (default value), 80, or 115. The OmniScan X3 has 
unipolar voltage (negative square pulse), while the 
OmniScan X3 64 has bipolar voltage (negative and positive 
square pulse). On the OmniScan X3 64, the voltage values 
are given in Peak-to-Peak voltage (Vpp) and range from 
10 Vpp to 160 Vpp. Equivalent voltage are typically 
stronger in bipolar than in unipolar
UT Connector: Used to set the voltage of the pulser to 
either 85 (default value), 155, or 295.

Frequency Displays the probe frequency value. The value can be 
edited if the probe selected in the scan plan is Unknown.

PW Used to select the pulse-width (PW) value. Select Auto to 
automatically adjust the pulse width according to the 
probe frequency. Select Edit to modify the value manually.
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Acq. Rate Used to set the value of the acquisition rate (Acq. Rate). 
The Acq. Rate value is defined for all groups and defines 
the repetition frequency of all channels. The product of 
Acq. Rate × Scan Resolution is equal to the scan speed if 
the inspection is set to Time, and is equal to the Max. Scan 
Speed for an inspection set to Encoder mode. If the 
scanning movement is faster than the Max. Scan Speed, 
data could be missed, which will be indicated by black 
lines. With encoders, the Acq. Rate features an energy-
saving mode whereby the Acq. Rate is lowered when the 
encoder is not moving. Enter a value, which will be the 
requested value. The software will use this value as the 
target to attain.
You can also choose one of the following presets:
Auto Max.: Uses the maximum available Acq. Rate value. 
An acquisition rate that is too high may generate ghost 
echoes in some specimen.
Default: The default value is 120 Hz. If the maximum 
available Acq. Rate is lower than 120, the default value is 
then set at this lower value.
Edit: You can enter a value manually.

The pulse repetition frequency (PRF) is the frequency 
at which pulses are emitted, whereas the acquisition 
rate (Acq. Rate) is the frequency at which all pulses 
(the total number of pulses) are emitted. The PRF and 
Acq. Rate are based on the inverse of the time interval 
between the emission of pulses. Acq. Rate is the 
inverse of TTotal and PRF is the inverse of TBeam, 
which are expressed in the following calculation: Acq. 
Rate = 1/TTotal. With a multiple group configuration, 
the acquisition rate takes into account the emission of 
pulses for all groups.

Table 9  UT Settings — Pulser (continued)

Option Description

NOTE
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2.7.1.3 Receiver

Using the Receiver parameter, you can see and modify the Filter, Rectifier, Video 
Filter, Averaging, and Reject options. To access these options, go to UT Settings > 
Receiver (see Figure 2-17 on page 49 and Table 10 on page 49).

Figure 2-17  UT Settings — Receiver

Interleave Set this parameter to ON to enable (OFF is the default) 
interleaving of the focal law firing sequence, which delays 
the appearance of ghost echoes.

Table 10  UT Settings — Receiver 

Option Description

Receiver The value mirrors the value of the Pulser (read-only) if the 
group is a PA group or a UT pulse-echo group. The value 
can be edited only if the group is a UT on PA in pitch-catch 
configuration.

Table 9  UT Settings — Pulser (continued)

Option Description
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Filter Used to select the appropriate filter value, such as TOFD or 
LP (low pass), HP (high pass), and BP (band pass).

Table 10  UT Settings — Receiver (continued)

Option Description
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Rectifier Used to set rectification of the A-scan signal. The four 
options are RF (radio frequency) non-rectified, HW+ (half 
wave positive), HW- (half wave negative), and FW (full 
wave), which are displayed below respectively.

Table 10  UT Settings — Receiver (continued)

Option Description
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2.7.1.4 Beam

Using the Beam parameter, you can see and modify the Scan Offset, Index Offset, 
Skew, Beam Delay, Gain Offset, and Refracted Angle options. To access these 
options, go to UT Settings > Beam (see Figure 2-18 on page 53 and Table 11 on 
page 53).

Rectifier 
(continued)

Video Filter PA/UT: When activated, this parameter enables the video-
smoothing filter. It is set according to the probe frequency 
and the rectification mode. The video filter is unavailable in 
RF mode.

Averaging Used to select an averaging value (1, 2, 4, 8, or 16) for the 
current group. The averaging value divides the PRF value. 
For example, changing the averaging value from 1 to 4 
causes an original PRF value of 1 kHz to drop to 250 Hz. 
The hardware still pulses at 1 kHz, but echo signals from all 
four pulses are averaged to produce a unique signal. 
Averaging is useful for reducing the noise on the echo 
signals. An averaging value of 1 corresponds to no 
averaging. For TOFD, averaging values of 32 and 64 are 
also possible.

Reject Signal amplitude inferior to the specified value is forced to 
0 %. The default value is set to 0 %.

Table 10  UT Settings — Receiver (continued)

Option Description
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Figure 2-18  UT Settings — Beam

Table 11  UT Settings — Beam 

Option Description

Scan Offset PA/UT/TOFD: Displays the value calculated in the scan 
plan. The beam Scan Offset is the additional scan offset of 
the current beam with respect to the probe scan offset 
defined in Probe & Part/Position. The total scan offset for 
a specific beam is the Probe Scan Offset + Beam Scan 
Offset.

Index Offset PA/UT/TOFD: The beam Index Offset is the difference 
between the 0-position marked on the part for inspection 
and the beam exit point on the index axis. The beam index 
offset is negative for a probe in the skew 90 position and 
positive for a probe in the skew 270 position.

Skew PA: Additional beam skew relative to the probe 
orientation (typically 90° or 270°). When the beam skew 
indicates 0°, it means the beam skew is aligned with the 
probe skew.
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2.7.1.5 Advanced

Using the Advanced parameter, you can see and modify the Ref. Amplitude, Auto 
80 %, Reference dB, Point Quantity, Compression, and Effective Digitizing 
Frequency options. To access these options, go to UT Settings > Advanced 
(see Figure 2-19 on page 54 and Table 12 on page 55).

Figure 2-19  UT Settings — Advanced

Beam Delay PA: Used to set the wedge delay for the selected focal law. 
Use the wedge delay calibration wizard to calculate the 
beam delay value for all beams. This parameter should 
only be used if you need to fine-tune the beam delay for 
the current focal law (expressed in µs (microseconds)).

Gain Offset PA: Displays the calculated gain offset applied to the 
current focal law. Values are typically created through the 
sensitivity calibration wizard, and they can be adjusted 
manually if needed (expressed in dB (decibels)).

Refracted Angle PA/TOFD: Displays the angle of the ultrasonic beam in the 
material.
UT: Sets the angle of the ultrasonic beam in the material. 
The nominal value appears between brackets.

Reference Point UT/TOFD: Sets the distance between the front edge of the 
wedge and the beam exit point. The nominal value 
appears between brackets.

Table 11  UT Settings — Beam (continued)

Option Description
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Table 12  UT Settings — Advanced 

Option Description

Ref. Amplitude Used to specify the A-scan full-screen height of the 
reference amplitude. The value is expressed as a percentage 
of the A-scan full-screen height. The default value is 80.0 %. 
The value modifies the value for Auto XX % gain 
adjustment and also sets the height of the reference line if 
activated.

Reference dB When turned on, this function freezes the current gain as 
the reference gain and adds an adjustment gain value 
(initially 0.0) to the Gain value field.
The gain applied (to all focal laws in PA) is the total of the 
reference gain and the adjustment gain. The Reference dB 
parameter is useful for inspections requiring the 
establishment of a reference gain, and the addition or 
subtraction of an adjustment gain.

Point Quantity PA/UT: Used to set the number of A-scan points to be 
stored. Increase this value to adjust the Compression factor 
to the desired value. Increasing the Point Quantity will 
first increase the range until the Compression can decrease, 
making sure the real UT range is never below the requested 
UT range (defined in UT Settings > General > Range).
The number of points in the A-scan and the scale factor, or 
compression, are directly related to file size.
TOFD: Displays the number of A-scan points to be stored. 
By default, this value is fixed and depends on the 
ultrasound range. The inspection range is determined in 
UT Settings > General > Range.
The number of points in the A-scan and the scale factor, or 
compression, are directly related to file size.
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2.7.2 TFM Settings

The TFM Settings menu enables you to access the General, Pulser, Zone, and 
Advanced parameters.

2.7.2.1 General

Using the General parameter, you can see and modify the L Velocity, T Velocity, 
Reference dB, and Envelope options. To access these options, go to TFM Settings > 
General (see Figure 2-20 on page 56 and Table 13 on page 57).

Figure 2-20  TFM Settings — General

Compression PA/UT: Displays the value of the A-scan compression. 
Depending on the inspection range and number of points, a 
compression value greater than 1 may be required. For 
example, a value of 6 will keep the maximum value of 
every 6 consecutive acquisition points in time. No maxima 
are missed.
TOFD: The compression is forced to 1 in TOFD and is read-
only.

Effective 
Digitizing 
Frequency

The Effective Digitizing Frequency is set to 100 MHz, 
which means that a data point is acquired at every 0.01 µs 
of the analog waveform. This value cannot be changed by 
the user.

Net Digitizing 
Frequency

The Net Digitizing Frequency is the result of the Effective 
Digitizing Frequency divided by the Compression. The 
result is used for code compliance. The value in brackets [ ] 
is the time interval between each A-scan point.

Table 12  UT Settings — Advanced (continued)

Option Description
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2.7.2.2 Pulser

Using the Pulser parameter, you can see and modify the Voltage, Frequency, PW, and 
Acq. Rate Mode options. To access these options, go to TFM Settings > Pulser 
(see Figure 2-21 on page 58 and Table 14 on page 58).

Table 13  TFM Settings — General 

Option Description

L Velocity Velocity of longitudinal waves in the material of the 
inspected part.
The material type and longitudinal wave velocity are 
normally set during the group creation as part of the scan 
plan process.

T Velocity Velocity of transversal waves in the material of the 
inspected part.
The material type and transversal wave velocity are 
normally set during the group creation as part of the scan 
plan process.

Reference dB When turned on, this function freezes the current gain as 
the reference gain and adds an adjustment gain value 
(initially 0.0) to the Gain value field.
The gain applied is the total of the reference gain and the 
adjustment gain. The Reference dB parameter is useful for 
inspections requiring the establishment of a reference gain, 
and the addition or subtraction of an adjustment gain.

Ref. 
Amplitude

Set the reference amplitude in percentage.

TFM Method You can only change the TFM method on OmniScan X3 64 
flaw detectors. The choices are either Delay-And-Sum or 
Phase Coherence Imaging (PCI). The TFM method can be 
applied to groups independently. For more information on 
PCI, see “Phase Coherence Imaging (PCI)” on page 210. 
For all OmniScan X3 models, the TFM method by default is 
Delay-And-Sum.
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Figure 2-21  TFM Settings — Pulser

Table 14  TFM Settings — Pulser 

Option Description

Select Pulser Indicates which element on the probe to be used as the first 
element of the pulser.

Voltage Voltage of the pulser. 
On an OmniScan X3 64 flaw detector, you can select 10 Vpp, 
20 Vpp, 40 Vpp, 80 Vpp, 120 Vpp, or 160 Vpp.
On an OmniScan X3 flaw detector you can select 40 V 
(default value), 80 V, or 115 V.

Frequency Probe-frequency value. To modify the frequency, select the 
Probe & Wedge Manager or change the probe in the scan 
plan.

PW Pulse-width (PW) value. The pulse width is automatically 
adjusted according to the probe frequency.
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Acq. Rate Used to set the value of the acquisition rate (Acq. Rate). The 
Acq. Rate value is defined for all groups and defines the 
repetition frequency of all channels. The product of Acq. 
Rate × Scan Resolution is equal to the scan speed if the 
inspection is set to Time, and is equal to the Max. Scan 
Speed for an inspection in Encoder mode. If the scanning 
movement is faster than the Max. Scan Speed, data could be 
missed and is indicated by black lines. With encoders, the 
Acq. Rate features an energy-saving mode, whereby the 
Acq. Rate is lowered when the encoder is not moving. Enter 
a value, which will be the requested value. The software will 
use this value as the target to be reached. You can also choose 
one of the following presets:
Auto Max.
Uses the maximum available Acq. Rate value.
Default (default value)
Sets the Acq. Rate to the minimum value between 120 Hz 
and the maximum acquisition rate available.
Edit
You can enter a value manually.

Table 14  TFM Settings — Pulser (continued)

Option Description
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2.7.2.3 Receiver

Using the Receiver parameter, you can define the filter to be applied on the TFM 
signal. To access this option, go to TFM Settings > Receiver (see Figure 2-22 on 
page 60 and Table 15 on page 61).

Figure 2-22  TFM Settings — Receiver

Sparse Adjusts the pulser sparsity of the FMC acquisition. The 
default Sparse value is set so a minimum of 16 elements are 
pulsed. For a 64-element probe, the default value is set to 1/4, 
For a probe with 16 elements or less, the default value is set 
to Full Matrix. The user can always change the value during 
setup. In a Full Matrix configuration (default), every element 
pulses and receives. Choosing a different Sparse value 
changes the number of pulsers that will be activated for 
pulsing, but all the elements are still used for receiving. The 
options are Full Matrix, 1/2, 1/3, 1/4, 1/8, and 1/16. With a 32-
element probe, for example, a value of 1/2 means that 16 
elements will be pulsed and all 32 elements will receive. 
Some options may not be displayed because a minimum of 4 
pulsers is required (for example, with a 16-element probe, 
1/8 and 1/16 are absent). Changing the Sparse value will, in 
most cases, increase the maximum Acq. Rate, but may result 
in a lower signal-to-noise ratio (SNR).

Table 14  TFM Settings — Pulser (continued)

Option Description
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2.7.2.4 Wave Set and Zone

Using the Zone parameter, you can see and modify the Min. Index, Max. Index, Min. 
Depth, and Max. Depth options. To access these options, go to TFM Settings > Wave 
Set and Zone (see Figure 2-23 on page 62 and Table 16 on page 62).

Table 15  TFM Settings — Receiver 

Option Description

Select Receiver Indicates which element on the probe to be used as the first 
element of the receiver.

Filter Select the appropriate filter value to be applied on the TFM 
signal.

Envelope Used to turn the Envelope ON (by default) or OFF. The 
envelope can be applied to groups independently.
The TFM envelope is produced by combining and 
extracting the norm of two signals: the real component of 
the elementary A-scan acquired through FMC and the 
Hilbert-transform imaginary component. The processing 
removes the signal oscillations in the TFM image and 
enables a more robust maximum amplitude measurement.
While calculating the envelope increases the computation 
burden on the software, it enables you to decrease the grid 
resolution and, as a result, increase the maximum Acq. 
Rate. 
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Figure 2-23  TFM Settings — Wave Set and Zone

2.7.2.5 Zone Resolution

Using the Zone Resolution parameter, you can see and modify the Resolution, 
pts/λL, pts/λT, and Amplitude Fidelity options. To access these options, go to TFM 
Settings > Zone Resolution (see Figure 2-24 on page 62 and Table 17 on page 63).

Figure 2-24  TFM Settings — Zone Resolution

Table 16  TFM Settings — Wave Set and Zone 

Option Description

Wave Set Displays the type of wave set selected in the scan plan.

Min. Index Used to set the limit for the left side of the TFM zone 
(orange outline in the scan plan representation). For weld 
inspections, zero is in the middle of the weld.

Max. Index Used to set the limit for the right side of the TFM zone 
(orange outline in the scan plan representation). For weld 
inspections, zero is in the middle of the weld).

Min. Depth Used to set the upper limit for the TFM zone (orange 
outline in the scan plan representation.

Max. Depth Used to set the lower limit for the TFM zone (orange 
outline in the scan plan representation).
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2.7.2.6 Aperture

Using the Aperture parameter, you can see the pulser and receiver settings as they 
were set up in the scan plan.

Figure 2-25  TFM Settings — Aperture

Table 17  TFM Settings — Zone Resolution 

Option Description

Resolution Used to set the distance between two pixels inside the TFM 
zone. Adjust the grid resolution to obtain a code-compliant 
Amplitude Fidelity.

pts/λL Displays the number of points per longitudinal wavelength, 
which is determined by the grid resolution setting.

pts/λT Displays the number of points per transversal wavelength, 
which is determined by the grid resolution setting.

Amplitude 
Fidelity

Displays the maximum possible amplitude variation (in dB) 
caused by the grid resolution itself. This model is based on 
empirical observations and takes into account the horizontal 
and vertical axes.
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2.7.3 Gates & Alarms

The Gate & Alarms menu enables you to access the Gate Main, Gate Advanced, 
Alarm, Output, and Thickness parameters.

Figure 2-26  Gates & Alarms

Table 18  TFM Settings — Aperture

Option Description

First Pulser Indicates the element No. used as the first element in the 
pulser.

Pulser Quantity Indicates the number of elements used for the pulser.

Last Pulser Indicates the element No. used as the last element in the 
pulser.

First Receiver Indicates the element No. used as the first element in the 
receiver.

Receiver Quantity Indicates the number of elements used for the receiver.

Last Receiver Indicates the element No. used as the last element in the 
receiver.
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2.7.3.1 Gate Main

Using the Gate Main parameter, you can see and modify the Select Gates, 
Activation, Geometry, Start, Width, and Threshold options. To access these options, 
go to Gate & Alarms > Gate Main (see Figure 2-27 on page 65 and Table 19 on 
page 65).

Figure 2-27  Gates & Alarms PA — Gate Main menu

Table 19  Gates & Alarms PA — Gate Main menu 

Option Description

Select Gates Used to select which gate parameters will be edited. You 
can choose between A, B, or I.

Activation Used to set the gate on the screen ON or OFF.
OmniScan Interface 65



10-001244-01EN, Rev. 13, April 2024
Geometry Used to set the type of gate: True Depth or Sound Path.

True Depth sets the gate according to the depth in the 
material.

Sound Path sets the gate according to the distance 
traveled in the material.

Table 19  Gates & Alarms PA — Gate Main menu (continued)

Option Description
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2.7.3.2 Gate Advanced

Using the Gate Advanced parameter, you can see and modify the Select Gates, 
Synchro, Peak, Measure, and Signal Polarity options. To access these options, go to 
Gate & Alarms > Gate Advanced (see Figure 2-28 on page 67 and Table 20 on 
page 67).

Figure 2-28  Gates & Alarms — Gate Advanced

Start Used to set the starting position of the selected gate. This 
position is relative to the gate synchronization. The real 
position of the gate is the synchronization position plus 
the gate start position. If the gate is not synchronized, 
then the Start is relative to the zero on the ultrasound 
axis.

Width Used to set the width of the gate (expressed in mm or 
in.).

Threshold Used to set the height of the gate in the A-scan. This 
parameter determines the amplitude of a signal in the 
gate for detection.

Table 20  Gates & Alarms — Gate Advanced 

Option Description

Select Gates Used to select which gate parameters will be edited. You 
can choose between A, B, or I.

Table 19  Gates & Alarms PA — Gate Main menu (continued)

Option Description
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Synchro (for 
Gate A and Gate 
B)

Used to specify the synchronization type of the selected 
gate.
Pulse: Synchronizes at the beginning of the pulse. It is the 
only selection available when using a group type other 
than Linear at 0°.
I/: Synchronizes where the signal crosses gate I. If the 
signal does not cross gate I, then it is synchronized at the 
end of gate I. Gate I must be active to use this option.
A^: Synchronizes at the position of the amplitude peak of 
gate A. If the signal does not cross gate A, it is 
synchronized at the end of gate A. This option is available 
for gate B only if you have selected Measure = Peak for 
gate A.
A/: Synchronizes where the signal first crosses gate A. If 
the signal does not cross gate A, then it is synchronized at 
the end of gate A. This option is available for gate B only if 
you have selected Measure = Edge for gate A.

A-scan Synchro Used to specify the A-scan synchronization type.
Pulse: Synchronizes at the beginning of the pulse. The 
ultrasound axis considers the Wedge Delay and Beam 
Delay, so the zero should be at the surface of the piece if 
the right side was selected in the scan plan. It is the only 
option available when using a group type other than 
Linear at 0°.
I/: Synchronizes the zero of the ultrasound axis on the 
signal at the first crossing in the gate I. Gate I must be 
active to have this option. Wedge and beam delays are 
forced to 0 when choosing this option.

Table 20  Gates & Alarms — Gate Advanced (continued)

Option Description
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2.7.3.3 Alarm

On the Alarm menu, you can set an alarm on all groups, all gates or any individual 
group or gate. A maximum of three alarms can be set. (See Figure 2-29 on page 69.)

Figure 2-29  Gates & Alarms — Alarm menu

Peak If the value of the Measure is set to Peak (^), the Peak 
setting enables you to choose if the readings are related to 
First Peak or Max Peak.
When Max Peak is selected for a specific gate (A, B, or I), 
the data, readings, and parameters displayed correspond 
only to the highest (or maximum) peak crossing this 
particular gate.
When First Peak is selected for a specific gate (A, B, or I), 
the data, readings, and parameters displayed correspond 
only to the first peak crossing this particular gate.

Measure Used to set the measure type of the current gate.
Peak (^): The data, readings, and parameters displayed 
correspond to either the Max Peak or First Peak, 
depending on the Peak setting.
Edge (/): The data, readings, and parameters displayed 
correspond to the first crossing point in the gate. The Peak 
setting has no influence.

Signal Polarity For rectified signals, the Signal Polarity is set to Positive, 
and is in read-only. For RF signals, the polarity is set to 
Absolute. When in the Absolute mode, all gates 
measurements consider the absolute value of the signal in 
the gate, regardless if the signal is positive or negative.

Table 20  Gates & Alarms — Gate Advanced (continued)

Option Description
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The left alarm indicator light is for Alarm 1, the middle is for Alarm 2 and the right for 
Alarm 3 (see Figure 2-30 on page 71).

Table 21  Gates & Alarms — Alarm 

Option Description

Select Alarm Choose the alarm to configure (Alarm 1 to Alarm 3).

Activation On or Off activates or deactivates the corresponding 
alarm indicator light visible on the instrument front panel 
(see Figure 2-30 on page 71).

Apply To Select a specific group or apply to All groups.

Condition 1 Set the gate condition triggering the alarm. The condition 
can be set to trigger the alarm when the signal meets a 
specific gate (e.g., Gate A) or when the signal does not 
meet a specific gate (e.g., Not Gate A).

Operator Select a logical operator linking the two conditions. 
The And operator activates the alarm when both 
conditions are met. 
The Or operator activates the alarm when either condition 
is met.

Condition 2 Set a second gate condition triggering the alarm. The 
condition can be set to trigger the alarm when the signal 
meets a specific gate (e.g., Gate B) or when the signal does 
not meet a specific gate (e.g., Not Gate B).

TIP
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Figure 2-30  Alarm indicator lights

2.7.3.4 Output

The Output menu enables you configure an alarm signal and send it to a digital 
output.

Figure 2-31  Gates & Alarms — Output menu

Table 22  Gates & Alarms — Output 

Option Description

Select Alarm Choose the alarm signal to configure (Alarm 1 to Alarm 3).

Count Enter the number of times the alarm condition must be 
met before triggering the alarm.

Delay Enter the delay between the occurrence of the alarm 
condition and the actual alarm trigger.

Hold Time Enter the duration of the alarm.

Digital output Use this to send the alarm signal to one of the three DOUT 
digital outputs.

Alarm 2
Alarm 3Alarm 1
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2.7.3.5 Thickness

Using the Thickness parameter, you can set the source for thickness measurements, 
and define the minimum and maximum of the thickness color palette. To access these 
options, go to Gate & Alarms > Thickness (see Figure 2-32 on page 72 and Table 23 
on page 72).

Figure 2-32  Gates & Alarms — Thickness

2.7.3.6 TFM Gates

The A gate is available when using TFM groups. Because the data in TFM is 
volumetric, a box gate is used that crops the data to a specific targeted zone within the 
end view. 

There are no advanced or thickness controls for the TFM gate, so only the Gates Main 
menu is available (see Figure 2-33 on page 72 and Table 24 on page 73).

Figure 2-33  Gates & Alarms — TFM

Table 23  Gates & Alarms — Thickness 

Option Description

Mode Selects the gate combination used to measure thickness.

Minimum The minimum thickness of the color scale for the 
thickness C-scan.

Maximum The maximum thickness of the color scale for the 
thickness C-scan.
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When in the raster scan mode, the Index Start and Index End are read only and 
locked to the TFM zone Index Start and Index End values.

2.7.4 Scan

The Scan menu enables you to access the Inspection and Area parameters.

2.7.4.1 Inspection

Using the Inspection parameter, you can see and modify the Type, Scan, and Encoder 
options. To access these options, go to Scan > Inspection (see Figure 2-34 on page 73 
and Table 25 on page 74).

Figure 2-34  Scan — Inspection

Table 24  Gates & Alarms — TFM 

Option Description

Activation Used to set the gate on the screen On or Off.

Index Start Used to set the start position of the selected gate in the 
index direction. The Index End is updated with the Index 
Start to maintain the same gate width.

Index End Used to set the end position of the selected gate in the 
index direction. The Index Start is not changed with the 
Index End.

Depth Start The same control as the Index Start but in the Depth 
direction.

Depth End The same control as the Index End but in the Depth 
direction.

Threshold Used to set the height of the gate in the A-scan. This 
parameter determines the amplitude of a signal in the 
gate for detection.
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Table 25  Scan — Inspection 

Option Description

Type Used to select the desired type of inspection. The following choices 
are available:
Time
Data acquisition at precise time intervals.
One-Line Encoded
In one-line scanning, the acquisition is based on an encoder.
Raster Encoded
When the phased array probe is moving on both the scan and index 
axes, the ultrasound data is acquired in a bidirectional or 
unidirectional scanning pattern.

Edit 
Encoder

Used to configure the encoder settings. This option enables you to 
configure the encoder resolution, polarity, and input. Refer to 
“Encoder Configuration” on page 75 to know more about encoder 
options.

 

Scan on 
Play

Defines the value of the Scan position that will be set when the user 
presses Play. The default value is the Area Scan Start.

Index on 
Play

Only available in Raster Encoded.
Defines the value of the Index position that will be set when the user 
presses Play. The default value is the Area Index Start.
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2.7.4.2 Encoder Configuration

On the Edit Encoders menu, you can select from a list of preset values or manually 
configure the encoders.

Scanner Presets

If you have an Evident scanner, you can choose it directly from the Scanner Presets 
tab (see Figure 2-35 on page 75). The resolution, input, and polarity will be 
automatically configured. You can still edit the parameters in the other available tabs 
(Scan Axis Encoder tab and the Index Axis Encoder tab).

Figure 2-35  Scanner Presets

Scan Axis Encoder and Index Axis Encoder

The Scan Axis Encoder tab and the Index Axis Encoder tab enable you to select and 
configure the encoder for each axis. It is also possible to calibrate the encoders on this 
menu. To access these options, go to Scan > Inspection (see Figure 2-34 on page 73 
and Table 26 on page 77), and then select Edit Encoders.
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ScanDeck

When the HydroFORM2 (Next-generation HydroFORM) scanner is selected, an 
additional menu is displayed in Scanner Presets. In this menu you can modify the 
encoder settings for the HydroFORM2.

You can adjust the Target Increment which sets the nominal index distance between 
each scan line. Also you can set the Warning Tolerance to allow a margin before 
getting a warning that the index distance has been exceeded. 

ScanDeck Quick Guide shows the Scandeck button usage for the Next-generation 
HydroFORM. (See Figure 2-36 on page 76.)

Figure 2-36  HydroFORM 2 ScanDeck
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Table 26  Scan — Encoder configuration

Option Description

Type Select the encoder type. Current choices are Quad and 
Clicker. Select Quad when the attached encoder (5 V TTL 
output) is a dual-channel output encoder. The channels 
are generally designated A and B. When the encoder is 
rotating clockwise (from left to right in the figure below), 
channel B follows channel A with a 90-degree delay.
When the encoder is rotating counterclockwise, 
channel A follows channel B with a 90-degree delay. In 
this way, you can determine if the rotation is clockwise or 
counterclockwise. The decoder counts one step each time 
it detects a rising or falling edge on channel A or 
channel B. This means that if the real encoder resolution 
is 1000 steps/revolution, the final resolution with the 
quadrature reading is 4000 steps/revolution.

Clicker Used when you use an Evident indexer device (clicker). 
Press the push-button of the indexer device to increment 
the position on the axis. The clicker is frequently used to 
perform a manual raster scan and is generally assigned to 
the Index axis.

Step Resolution If the encoder type is Quad, then the resolution is the 
number of encoder counts per unit for the selected 
encoder. With the Clicker type, the resolution is the 
increment in the axis when the clicker is pressed.

Polarity Used to reverse the count of the encoder. Select between 
Normal and Inverse.

Encoder Input Select the input source for the selected axis. In a Raster 
scan, choosing an input for the Scan Axis automatically 
selects the input for the Index Axis.
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Preset When using a clicker, it is possible to turn ON/OFF the 
preset at a fixed value. If the Preset is OFF, when pressing 
the clicker, the scan axis value remains the same. When 
Preset is ON, pressing the clicker will change the scan 
axis encoder value to the axis origin. Can be used to 
simplify the inspection workflow and adjust it to your 
scanning pattern.

Calibration To calibrate the encoder resolution, first define the real 
distance the encoder will travel. Then click Reset to 
restart the encoder count and move the encoder by the 
specified distance. Then press Calibrate to convert the 
encoder count and the distance to the Encoder 
Resolution.
Distance: Used to set the distance for the calibration.
Calibrate: Used to confirm the distance for the 
calibration.
Reset: Reinitializes the distance of the encoder to 0.
Distance (bottom): Displays the actual distance that the 
encoder traveled.

Index start 
bound on clicker 
step

This option is only available with a 0° with overlap 
group, and when the Index axis is set to Clicker. Turning 
ON this feature forces the Index Start value to be a 
multiple of the clicker step, or clicker resolution. The 
typical use case is the inspection of a pipe with the 
FlexoFORM. In this case, the zero index is referenced on 
the top of the pipe, with the index Start and Index End set 
on each side of the reference (Index Start is negative). 
With Index start bound on clicker step set to ON, this 
guarantees that using the clicker, the index position will 
pass exactly by zero, exactly on the reference. It avoids 
unnecessary calculation to match the Index Start 
perfectly.

Table 26  Scan — Encoder configuration (continued)

Option Description
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2.7.4.3 Area

Using the Area parameter, you can see and modify the Scan Start, Scan End, and 
Scan Res. options. To access these options, go to Scan > Area (see Figure 2-37 on 
page 79 and Table 27 on page 79).

Figure 2-37  Scan — Area

2.7.4.4 Digital Inputs

The Digital Inputs option enables you to configure the digital inputs (DIN). Each of 
the four DINn parameters has an exclusive function. The listed functions can be 
assigned to any digital input (see Table 28 on page 80).

Table 27  Scan — Area 

Option Description

Scan Start Used to set the starting location of the scan (expressed in 
mm or in.).

Scan End Used to set the maximum distance you can scan (expressed 
in mm or in.).

Scan Res. Used to set the step (resolution) at which the points will be 
acquired on the scan (expressed in mm or in.).

Index Start (Raster scan only) Used to set the starting location of the 
raster scan in the index axis (expressed in mm or in.).

Index End (Raster scan only) Used to set the raster end location in the 
index axis (expressed in mm or in.).

Index 
Res./Index 
Step

(Raster scan only) Determines the index resolution. Cannot 
be modified in the Linear at 0° scan.
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Use the digital inputs to control the OmniScan X3 flaw detector remotely. Connect 
your remote controller to the appropriate OmniScan connector. Refer to the 
OmniScan X3 User’s Manual for details on the signals and connectors.

When using a preset scanner that has digital input by default, the Digital Inputs 
section will already be filled.

2.7.5 Probe & Part

The Probe & Part menu enables you to edit parameters related to the positioning and 
overlay, as well as create your custom probes and wedges in the Probe & Wedge 
Manager.

2.7.5.1 Position

Using the Position parameter, you can see and modify the Skew, Scan Offset, and 
Index Offset options. To access these options, go to Probe & Part > Position 
(see Figure 2-38 on page 81 and Table 29 on page 81).

Table 28  Digital input options

Option Description

Pause/Resume Used to switch back and forth between inspection mode 
and analysis mode. The mode changes when the remote 
signal rises from the low to the high level. This is equivalent 
to manually pressing the Pause key ().

Save Data Used to save the data when the remote signal rises from the 
low to the high level. This is equivalent to manually 
pressing the Save key ().

Clear All Used to clear all data when the remote signal rises from the 
low to the high level. This is equivalent to manually 
pressing the Play key ().

Acquisition 
step

While holding this DIN active, the acquisition is 
temporarily frozen. You can only define this option on 
DIN 3. 
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Figure 2-38  Probe & Part —Position

Table 29  Probe & Part — Position options 

Option Description

Skew Orientation of the ultrasonic beam relative to the scan axis. 
Skew 90 and skew 270 are typically used to define a two-
sided, two-probe inspection.

Scan Offset The Scan Offset is the difference between the 0 position 
marked on the part for inspection and the real start 
position for the probe center on the scan axis.
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2.7.5.2 Part

Using the Part parameter, you can see and modify the Thickness option. To access 
this option go to Probe & Part > Part (see Figure 2-39 on page 82 and Table 30 on 
page 83).

Figure 2-39  Probe & Part — Part

Index Offset The beam index offset is the difference between the 0 
position marked on the part for inspection and the real 
start position for the probe front edge on the index axis. 
The beam index offset is negative for a probe in the skew 
90 position and positive for a probe in the skew 270 
position. The Index Offset cannot be edited in TFM, 
because it affects the calculation of the focal laws. Use the 
Scan Plan to change the Probe Index Offset in TFM.

Table 29  Probe & Part — Position options (continued)

Option Description
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2.7.5.3 Probe & Wedge Manager

To manage custom probes and wedges, see “Probe & Wedge Manager” on page 197.

2.7.5.4 Weld or Custom Overlay

The title of this submenu varies depending on the choice made in the scan plan. If no 
overlay is selected, this menu does not appear. If a weld overlay is selected, the Weld 
menu enables you to edit directly (see the description for each parameter in Table 64 
on page 138) the following parameters:

• Hot Pass Height
• Hot Pass Angle
• Land Height
• Land Offset
• Root Height
• Root Angle

Parameters that are not relevant or cannot be edited because they depend on other 
values are read-only.

If the option selected in the scan plan for the overlay is Custom, then this section is 
titled Custom Overlay and the following parameters are available to edit:

• Scale
• Rotate
• Horizontal/Vertical Pan
• Horizontal/Vertical Flip

The description for each parameter can be found in “Part & Weld Tab” on page 132.

Table 30  Probe & Part — Part

Option Description

Thickness Used to set the thickness of the part you will scan. This 
value is mostly used to fit the overlay and the legs on the 
signal by adjusting to the real thickness rather than the 
nominal value. This value cannot be edited in TFM, 
because it affects the calculation of the focal laws. Use the 
Scan Plan to change the Part Thickness in TFM.
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2.7.6 Focal Laws

The Focal Laws menu enables you to access the Aperture and Beam parameters.

2.7.6.1 Aperture

Using the Aperture parameter, you can see and modify the Element Qty, First 
Element, and Last Element options. To access these options, go to Focal Laws > 
Aperture (see Figure 2-40 on page 84 and Table 31 on page 84).

Figure 2-40  Focal Laws — Aperture

2.7.6.2 Beam

Using the Beam parameter, you can edit the focal laws directly, avoiding going back 
and forth to the scan plan. To access the Min. Angle, Max. Angle, Angle Step, Angle, 
Focus, and Skew Angle options, go to Focal Laws > Beam (see Figure 2-41 on page 85 
and Table 32 on page 85).

Table 31  Focal Laws — Aperture 

Option Description

Element Qty Used to set the number of elements of each aperture.

First Element Used to set the first element of the first aperture.

Last Element Used to set the last element of the last focal law.

Element Step Used to see the element step between each focal law 
when the Linear scan type is chosen.
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Figure 2-41  Focal Laws —Beam

2.7.7 Measurements

The Measurements menu enables you to access the Cursors parameter.

Cursors

Using the Cursors parameter, you can edit the cursor position. Cursors can also be 
moved by tapping directly on the cursor in the layout. To access the Cursors tab, go to 
Measurements > Cursors (see Figure 2-42 on page 86 and Table 33 on page 86).

Table 32  Focal Laws — Beam 

Option Description

Min. Angle Used to set the minimum angle of the beam 
(Sectorial/Compound law configuration).

Max. Angle Used to set the maximum angle of the beam 
(Sectorial/Compound law configuration).

Angle Step Used to set the step value between each angle 
(Sectorial/Compound law configuration).

Angle Used to set the refracted angle of all the beams (Linear law 
configuration).

Focus Used to set the focusing depth of the part to be inspected.

Skew Angle Used to steer the beams at an angle different than the 
nominal beam skew. This option requires probes with the 
ability to steer the beam in the passive axis (matrix probes).
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Figure 2-42  Measurements — Cursors

Table 33  Measurements — Cursors 

Option Description

Cursor Category Used to select the view for the current layout in which 
you want to move the cursor positions. The choice of 
available views (A-scan, B-scan, C-scan, S-scan, TFM 
End View, TFM Side View, TFM Top View, or Data) 
depends on the current layout selected. The parameters 
appearing to the right of Category apply to the selected 
view.

Linked Used to determine whether the reference and 
measurement cursors are moved individually (Off) or 
simultaneously (On). This parameter affects the 
parameters in the Measurements > Cursors submenu and 
the pop-up button for the cursor parameter.

%(...) The position on the amplitude axis of the reference cursor 
(r), (r&m), or the measurement cursor (m).

Delta %(r&m) The difference on the amplitude axis between the 
reference cursor and the measurement cursor (only when 
cursors are linked).

U(...) The position on the ultrasound axis of the reference cursor 
(r), (r&m), or the measurement cursor (m).

Delta U (r&m) The difference on the ultrasound axis between the 
reference cursor and the measurement (only when cursors 
are linked).

I (...) The position on the index axis of the reference cursor (r), 
(r&m), or the measurement cursor (m).
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2.7.8 Display

The Display menu enables you to access various display parameters.

2.7.8.1 Compliance

Using the Compliance parameter, you can add compliance curves (sizing curves with 
a dB offset) to the sizing curves. It is available if a TCG or DAC calibration has been 
performed. If a DGS calibration is applied, use the menu Scan Plan > Manage DGS 
(see Figure 2-43 on page 88 and Table 34 on page 88).

Delta I (r&m) The difference on the index axis between the reference 
cursor and the measurement (only when cursors are 
linked).

S (...) The position on the scan axis of the reference cursor (r), 
(r&m), or the measurement cursor (m).

Delta S (r&m) The difference on the scan axis between the reference 
cursor and the measurement (only when cursors are 
linked).

D (...) The position on the depth axis in TFM of the reference 
cursor (r), (r&m), or the measurement cursor (m).

Delta D (r&m) The difference on the depth axis in TFM between the 
reference cursor and the measurement (only when cursors 
are linked).

Table 33  Measurements — Cursors (continued)

Option Description
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Figure 2-43  Display — Compliance

Table 34  Display — Compliance

Option Description

DAC 
Compliance

Used to apply preset compliance curves according to a 
specific code (JIS or ASME). Choose Custom to manually 
create curves.

Curve Type Used to select the type of interpolation between the DAC 
points: Linear or Polynomial.

Curve Quantity Used to display the number of compliance curves to 
manage.

Selected Curve Used to select the compliance curve to edit. The default 
selection is the Sizing curve, which cannot be edited. 
Select another curve to edit its Amplitude Offset.

Amplitude 
Offset

The dB difference between the Sizing curve and the 
selected compliance curve.
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2.7.8.2 Overlay

The Overlay parameter enables you to use multiple legs (On) or a single leg (Off) in 
the Overlay. The use of multiple legs will cause the weld or custom overlay to be 
flipped at each rebound.

2.7.8.3 Data Source

On the Data Source menu, you can modify the A-Scan, Primary C-scan, Secondary C-
scan, and Merged B-Scan options. To access these options, go to Display > Data 
Source (see Figure 2-44 on page 89 and Table 35 on page 89).

Figure 2-44  Display — Data Source

Table 35  Display — Data Source 

Option Description

A-Scan Select which A-scan is displayed on the A-scan view.
Normal: The displayed A-scan is the one that is currently 
selected; using the data cursor or the Angle/VPA selector in 
the top bar.
Highest (%): The data cursor automatically tracks the focal 
law with the highest amplitude in Gate A. If no signal 
crosses the threshold, then the selected A-scan defaults to 
the first one.
Thinnest: The data cursor automatically tracks the focal law 
with the thinnest measured thickness. Make sure that the 
thickness measurement is correctly defined in Gates & 
Alarms > Thickness > Mode. 

 
Highest and Thinnest tracking modes are not available in 
analysis mode. And, when these tracking modes are active, 
all layouts containing a B-scan are deactivated.

NOTE
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When in TFM mode, the Data Source menu can be edited to select how the data is 
represented (See Figure 2-45 on page 90 and Table 36 on page 90). Because the gate in 
TFM is a box shaped, the data source has an influence on both the top and the end 
views.

Figure 2-45  Display — Data Source, TFM mode

Primary C-scan Select the source of the C-scan for all layouts containing a C-
scan. The source can be A%, B%, I%, I/, or Thickness. Some 
options may not be available if the related gate is not active. 
For a Thickness C-scan, choose the Thickness mode in 
Gates & Alarms > Thickness > Mode.

Secondary C-scan Select the source of the second C-scan in an A-C-C layout. 
The source can be A%, B%, I%, I/, or Thickness. Some 
options may not be available if the related gate is not active. 
For a Thickness C-scan, choose the Thickness mode in Gates 
& Alarms > Thickness > Mode.

Merged B-Scan Choose to turn On or Off the Merged B-Scan in A-B-S and 
A-B-C-S layouts.

Merged B-Scan 
First Beam

Used to change the angle of the first beam. Data below the 
set angle is not displayed in the merged B-Scan. 

Merged B-Scan 
Last Beam

Used to change the angle of the last beam. Data above the 
set angle is not displayed in the merged B-Scan. 

Table 36  Display — Data Source, TFM mode

Option Description

All Data Displays all the data in the End View.

Table 35  Display — Data Source (continued)

Option Description
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2.7.8.4 Grid

Using the Grid parameter, you can see and modify the A-scan background grid 
parameters. To activate the grid, use the menu View and turn the Grid on. To access 
these options, go to Display > Grid (see Figure 2-46 on page 91 and Table 37 on 
page 91).

Figure 2-46  Display — Grid

2.7.8.5 Cursors and Axes

Using the Cursors and Axes parameter, you can display and modify the Values and 
C-Scan Axes options. To access this option go to Display > Cursors (see Figure 2-47 
on page 92 and Table 38 on page 92).

Gate A Displays only the data within the A gate, in Top and End 
views.

Table 37  Display — Grid 

Option Description

Ultrasound Cell Qty Used to set the number of grid cells for the ultrasound 
axis.

Amplitude Cell Qty Used to set the number of grid cells for the amplitude 
axis.

Color Used to set the color of the grid.

Table 36  Display — Data Source, TFM mode

Option Description
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Figure 2-47  Display — Cursors and Axes

2.7.8.6 Default Zoom

Using the Default Zoom parameter, you can see and modify the Default Zoom 
options. To access this option go to Display > Default Zoom (see Figure 2-48 on 
page 93 and Table 39 on page 92).

Table 38  Display — Cursors and Axes 

Option Description

Values Used to display the values (expressed in mm or in.) on the 
various cursor by tapping the Cursor Values button to turn it 
ON or OFF (default).

C-Scan Axes Used to toggle the orientation of the index axis.

Table 39  Display — Default Zoom 

Option Description

Scan Default 
Zoom

Used to set the size of the zoom window when the default 
zoom is applied.
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Figure 2-48  Display — Default Zoom

2.7.9 Preferences

The Preferences menu enables you to access the Date & Time, Regional, Data, 
Connectivity Settings, System, and About parameters.

2.7.9.1 Date & Time

Using the Date &Time parameter, you can see and modify the Time Zone, Clock 
Format, and Date Format options. To access these options, go to Preferences > Date 
&Time (see Figure 2-49 on page 93 and Table 40 on page 94).

Figure 2-49  Preferences — Date & Time

Set to Scan 
Default Zoom

To use the preset default zoom, these conditions must be met:
• The inspection is a one-line scan or raster scan.
• The current layout must contain a C-scan and/or a B-scan 

view.
• The C-scan or B-scan must already be in zoom mode.
Zoom in a C-scan or B-scan, and click Set to Scan Default 
Zoom. This will change the zoom length on the scan axis to 
the preset value.

Table 39  Display — Default Zoom (continued)

Option Description
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2.7.9.2 Regional

Using the Regional parameter, you can see and modify the Units, Decimal Separator, 
Thousands Separator, Adjust Time, and Adjust Date options. To access these 
options, go to Preferences > Regional (see Figure 2-50 on page 94 and Table 41 on 
page 95).

Figure 2-50  Preferences — Regional

Table 40  Preferences — Date & Time 

Option Description

Time Zone Used to set the time zone of your instrument.

The instrument may be unable to connect to the  
CLOUD if the time zone is incorrectly set.

Clock Format Used to set the format of the clock. You have the choice 
between 12h or 24h.

Date Format Used to set the date format. You have the following choices:
YYYY/MM/DD
YYYY-MM-DD
MM-DD-YYYY
MM/DD/YYYY
DD-MM-YYYY
DD/MM/YYYY

IMPORTANT
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2.7.9.3 Data

Using the Data parameter, you can see the Scan Storage settings and modify the 
Geolocation options. To access these options, go to Preferences > Data 
(see Figure 2-51 on page 95 and Table 42 on page 95).

Figure 2-51  Preferences — Data

Table 41  Preferences — Regional 

Option Description

Units Used to set the length measurement units to either 
metric (millimeters) or US customary (inches).

Decimal Separator Displays the decimal separator.

Thousands 
Separator

Displays the thousands separator.

Adjust Time Used to set the time of your instrument.

Adjust Date Used to set the date of your instrument.

Table 42  Preferences — Data 

Option Description

Scan Storage Displays which scans can be saved.
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2.7.9.4 Connectivity Settings

The Connectivity Settings enable you to turn ON or OFF the Wireless, OSC Connect 
(required to use the X3 RCS), and OneDrive options (see Figure 2-52 on page 96).

Figure 2-52  Preferences — Connectivity Settings

Wireless

Using the Wireless parameter, you can see and modify the Wireless Enabled, 
Security, Password, Show Password, Advanced Options, Add Network, Refresh, 
Done, and Connect parameters. To access these options, go to Preferences > Wireless  
(see Figure 2-53 on page 97 and Table 43 on page 97).

In the Wireless Properties window, the security level of your selected network is 
automatically detected.

Geolocation Used to turn ON the geolocation to include the GPS 
coordinates in the data file. If the instrument is not 
connected to a wireless LAN network, the geolocation 
module obtains its position using GPS satellites. Though 
this makes it slower to acquire its position, it offers high 
precision in the field, yet low precision indoors. If the 
instrument is connected to a wireless network, then the 
instrument can use the network to get its location (offering 
rapid geolocation and better precision indoors, yet lower 
precision if the network connection is weak).

Table 42  Preferences — Data (continued)

Option Description
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Figure 2-53  Wireless Properties window

Table 43  Preferences — Connectivity Settings — Wireless 

Option Description

Wireless Enabled The check box used to turn the Wireless Enabled on. A 
check mark means that it is enabled.

Security Used to indicate the security level of the chosen wireless 
network, such as WEP, WPA,WPA2, and EAP.

Password Used to enter the password of the chosen network.

Show Password Used to reveal or hide the password.

Advanced Options Used to set different options, such as enable the DHCP, 
enter the IP Address manually, enter the Subnet Mask 
manually, enter the Gateway manually, enter the DNS 
Server 1 manually, and enter the DNS Server 2 manually 
(for the WPA2).

Add Network Used to manually add a wireless network with different 
options, such as Security and Network Name.
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OSC Connect

To use the X3 Remote Collaboration Service (X3 RCS), your OmniScan X3 unit needs a 
valid connection to the Olympus Scientific Cloud (OSC). See “Olympus Scientific 
Cloud (OSC) Connection” on page 217.

OneDrive

Uploading and downloading files from the OneDrive cloud storage is done in the File 
Manager. See the “Using the File Manager” on page 192 for more details.

To connect to OneDrive

1. Select the OneDrive button to begin the login process. You must repeat this 
process if you reboot the OmniScan X3 unit because user names and passwords 
are not saved on the instrument for safety reasons.

2. You must read and accept the Privacy Statement to use OneDrive.
3. Enter your login. If you do not have a OneDrive account, you must create one 

using another device (account creation is locked on the OmniScan X3 unit).
4. Enter your password.
5. If required, enter the PIN to complete the two-factor authentication.

To disconnect from OneDrive

 Select the OneDrive button to disconnect. If you reboot the OmniScan X3 unit, the 
connection with OneDrive is lost. 

Refresh Used to refresh the available wireless networks.

Done Used to close and confirm.

Connect Used to connect to the chosen wireless network.

Table 43  Preferences — Connectivity Settings — Wireless (continued)

Option Description

IMPORTANT
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2.7.9.5 System

Using the System parameter, you can turn off the automatic launch of the MXU 
software if it was activated. To access this, go to Preferences > System (see Figure 2-54 
on page 99 and Table 44 on page 99).

Figure 2-54  Preferences — System

2.7.9.6 About

Using the About parameter, you can verify the System Information, Legal 
Information, Licenses, and FCC information. To access these options, go to 
Preferences > About (see Figure 2-55 on page 100 and Table 45 on page 100).

Table 44  Preferences — System 

Option Description

Boot Launcher Used to set the start-up of the OmniScan X3 flaw detector 
to either Manual (accesses the launcher) or Automatic 
(continues to the MXU software automatically).
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Figure 2-55  Preferences — About window

Table 45  Preferences — About 

Option Description

System Information Displays the Model, Software Version, Manufacturer, 
and Details. The details may vary from a version to 
another, but generally includes the list of the new 
features with respect to the previous version.

Legal Information Displays the legal information, such as the patent rights 
protection.

Licenses Displays the different license agreements from Evident. 

FCC Displays the Federal Communications Commission 
(FCC) Supplier’s Declaration of Conformity.

Done Used to confirm the terms of this section and exit this 
window.
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2.8 View Menu

The  View menu provides a range of submenus for inspection configuration 
(see Figure 2-56 on page 101 and Table 46 on page 101).

Figure 2-56  View menu window

Table 46  View menu options 

Option Description

Single / Multiple The View menu enables you to display the current group 
(Single) or multiple groups (Multiple).

Readings To display the readings on the right of the screen, tap the 
Readings toggle button (ON/OFF) to rapidly activate or 
deactivate the Readings display.

Grid To display the grid on the A-scan, tap the Grid toggle 
button (ON/OFF) to rapidly activate or deactivate the 
Grid display.
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Weld/Overlay To display the overlay of the weld on the S-scan, tap the 
Weld toggle button (ON/OFF) to rapidly activate or 
deactivate the Weld display. If a custom overlay is 
selected, this item is displayed as Overlay and can also 
be toggled ON/OFF.

Cursor To display the cursors on every scan view, tap the Cursor 
toggle button (ON/OFF) to rapidly activate or deactivate 
the Cursor display.

Legs To display the legs on every scan view, tap the Legs 
toggle button (ON/OFF) to rapidly activate or deactivate 
the Legs display.

Gates To display the gates using the View menu, tap the Gates 
toggle button to rapidly activate or deactivate the gates 
display. At least one gate should be activated to enable 
the display.
Make sure that the required inspection gates are 
activated in Gates & Alarms > Gates Main.

Brightness Tap the minus button to decrease the screen brightness 
or tap the plus button to increase the screen brightness 
(expressed in a percentage).

Indoor/Outdoor Toggle between the Outdoor or Indoor color scheme. 
The Indoor color scheme has a dark background with 
white text, while the Outdoor scheme has a white 
background with dark text for better contrast.

Table 46  View menu options (continued)

Option Description
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The  View menu enables or disables the display of the gates, but the gates can still 
be used for your setup. However, if the Activation parameter is set to OFF (under 
Gates & Alarms > Gates Main), the gates are disabled and cannot be used for your 
setup.

If your inspected part includes an overlay (weld or custom), you can toggle the 
visibility of the overlay. The overlay is a drawing of the weld geometry or your 
selected drawing superimposed on the S-scan view. This feature can help you 

Scan Plan In OmniPC software, there is an additional option on the 
View menu, the Scan Plan view. Selecting this Scan Plan 
option opens a window that contains a schema of the 
scan plan. The following parameters are available:

• Group selection
• View orientation (Top, Side, End, 3D)
• Zoom
• Show part (ON/OFF)
• Show all groups/current group
• Scan Offset of the current group
• Index Offset of the current group

Table 46  View menu options (continued)

Option Description

NOTE
OmniScan Interface 103



10-001244-01EN, Rev. 13, April 2024
visualize where indications are located relative to the part or weld geometry 
(see Figure 2-57 on page 104). Overlay reflection (to take into account the second leg, 
third leg, etc.) can be turned ON/OFF in the Menu > Display > Overlay > Multiple 
Legs.

 

Figure 2-57  Example of a V-Offset weld geometry overlay

2.9 Scan and Index Indicators and Parameters

The Scan and Index parameters (see Figure 2-58 on page 105) have two purposes. The 
values in the Scan and Index fields indicate the current position of the data cursors, 
but they can also be used to change the position of the data cursors.

Weld geometry 
overlay

Weld geometry 
overlay reflection 
for the second leg

Color palette 
ruler/scale
Chapter 2104



10-001244-01EN, Rev. 13, April 2024
Figure 2-58  Scan and Index indicators and parameters

Table 48 on page 109 presents the Scan and Index functions depending on the 
configuration and acquisition mode.

Table 47  Scan and Index functions

During acquisition During analysis (paused)

Inspection 
type Scan Index Scan Index

Time Displays elapsed 
time since the 
acquisition began 
[Play key ()].

N/A Navigates the data 
by scrolling along 
the scan axis or 
jumping to a 
specific location.

N/A

One-Line 
Encoded

Reads the current 
position along the 
scan axis.
Jumps to a specific 
scan position in 
order to set the 
encoder value on 
the fly.

N/A Navigates the data 
by scrolling along 
the scan axis or 
jumping to a 
specific location.

N/A
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Typical Use Cases

1. Setting or correcting the positions of the scan and index encoders during 
acquisition to compensate for obstacles. 
When scanning components with complex shapes and obstacles (such as a 
pressure vessel), you may need to correct the encoders’ position read by the 
OmniScan X3 unit to reflect the actual probe position. The Scan and Index 
parameters enable you to edit the current encoder positions to a specific value, 
and “force” them into a specific position.

To change the scan or index encoder position during data acquisition, follow 
these steps (order is important).

a) Make sure that the scanner or probe is in the correct position and stationary.
b) As needed, clear the data [Play key ()]. This may not be desirable if data has 

already been acquired.
c) Press either the Scan or Index control. A menu opens that enables you to type 

a new value using the numerical keypad or to invert the encoder polarity 
(see Figure 2-59 on page 107).

Raster 
Encoded

Reads the current 
position along the 
scan axis.
Jumps to a specific 
scan position in 
order to set the 
encoder value on 
the fly.

Reads the 
current 
position along 
the index axis.
Jumps to a 
specific index 
position in 
order to set the 
encoder value 
on the fly.

Navigates the data 
by scrolling along 
the scan axis or 
jumping to a 
specific location.

Navigates 
the data by 
scrolling 
along the 
index axis or 
jumping to a 
specific 
location.

Table 47  Scan and Index functions (continued)

During acquisition During analysis (paused)
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Figure 2-59  Jumping to a specific location by typing a number with the numerical 
keypad

If you frequently need to reset the encoder positions, consider configuring the Scan 
on Play and Index on Play parameters to reset the encoders at the start of each 
acquisition, eliminating the need to edit them every time. See Table 23 on page 72 for 
more details. 

2. Performing data analysis.
Navigate the data by tapping the Scan or Index parameter, and then turning the 
OmniScan X3 knob to scroll the data cursor.

2.10 Changing the Color Palettes

You can change the color palettes for the amplitude (B-scan, C-scan, or S-scan for 
PA/UT or End, Side, or Top view for TFM) or thickness C-scan.

To change a color palette

 Tap and hold the color palette ruler/scale (shown on the right side of Figure 2-57 
on page 104), and then select Load. Review the available color palettes, and tap 
Open to change the palette (see Figure 2-60 on page 108).
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Figure 2-60  Color palette selector

To change the color palette bounds

 By tapping once on the amplitude/thickness ruler, it is possible to effectively 
zoom on the color palette. Tapping to the bottom of the ruler opens a pop-up 
indicating Start, which allows to change the start of the color palette. Everything 
below the Start value is the same color. Tapping the top of the color palette ruler 
opens a pop-up indicating Range, which allows to change the range of the color 
palette. 

To restore the default palette

 Long press the palette ruler/scale (shown on the right side of Figure 2-57 on 
page 104) and select Restore Default Palette (see Figure 2-61 on page 108).

Figure 2-61  Restore Default Palette
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2.11 Files

Tap the  File menu to load a setup file (inspection mode) or data file (analysis 
mode), to preview a report, or to manage other options (see Figure 2-62 on page 109 
and Table 48 on page 109).

Figure 2-62  File menu

Table 48  File menu options

Option Description

Open Tap to open a setup file for acquisition or a data file for 
analysis.

New Used to create a new file by loading the default setup.

Save Setup As Used to save the current setup with a different name.
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Save Data As Opens the data saving prompt.

File Name: Enter the base file name of the data file. 
Select either OmniScan X3 or an external drive, USB or SD 
card as the save location.
If File Name Increment is set to None, this will be the 
final file name. 
If File Name Increment is selected, the base file name is a 
prefix, and the final name will have a suffix depending on 
your increment selection.
Numeric: Add a number in the format _#### at the end of 
the base file name.
Timestamp: Add the current time in the format 
yyyy_mm_dd ##h##m##s at the end of the base file name.
Numbering Start: Choose the first number used for file 
name increment.
Prompt every time: If this box is checked (default), every 
time you press the Save key (), the Save Data As 
prompt is displayed. If a File Name Increment (numeric 
or time) is selected, you can uncheck this box to auto-
increment the base file name every time the Save key () 
is pressed. This prompt will not appear until you select 
Save Data As again.
File Size and Free Space are displayed for the selected 
drive.

Indication 
Table Manager

Used to set up the Indication Table during your live 
analysis.

File Manager Used to manage files by deleting, renaming, or 
transferring them.

Table 48  File menu options (continued)

Option Description
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2.12 Readings

All ten readings displayed on the right-hand side of the screen are included in a 
generated report and saved in a setup file. You can easily switch which UT parameters 
are displayed in the readings, either individually or as a list. A description for each 
parameter is provided in the readings Select menu when it is highlighted 
(see Figure 2-63 on page 111).

To select the reading list to be displayed

1. Tap and hold any of the readings to open a contextual menu.
2. Choose between Select Reading List (changes all the displayed parameters from 

a predefined list) or Select Reading (edits one reading at a time):
a) With Select Reading List, you can choose from a list of preconfigured 

readings (see Figure 2-63 on page 111).

Figure 2-63  Selecting the Reading List

Report Used to create a report from the Indication Table 
Manager.

Table 48  File menu options (continued)

Option Description
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The Select Reading List option sets all ten readings at once so they are optimized for 
applications such as PA+TOFD, TOFD, Manual Weld and Automated Weld.

b) With Select Reading, you can replace one specific reading with any of the 
available readings (see Figure 2-64 on page 112).

Figure 2-64  Reading selection example

The Select Reading option is used to change the reading you have selected. You can 
change it for different groups, such as Gate, Positioning, and Cursor.

NOTE

NOTE
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2.12.1 Gate Category Reading

Table 49 on page 113 shows the Gate category reading codes and their descriptions.

2.12.2 Positioning Category Reading

Table 50 on page 114 shows the Positioning category reading codes and their 
descriptions. If the gate Measure option is set to Edge (/), then the description refers to 
the crossing point in the gate rather than the peak.

Table 49  Gate reading code descriptions 

Category Description

A% Peak amplitude of the signal detected in gate A. The measured peak 
depends of the Peak settings: Max Peak or First Peak.

B% Peak amplitude of the signal detected in gate B. The measured peak 
depends of the Peak settings: Max Peak or First Peak.

I% Peak amplitude of the signal detected in gate I. The measured peak 
depends of the Peak settings: Max Peak or First Peak.

A^ or 
(A/)

Position of the signal peak value in gate A (or crossing point in gate 
A). The measurement taken depends on the gate mode that is 
selected.

B^ or 
(B/)

Position of the signal peak value in gate B (or crossing point in gate 
B). The measurement taken depends on the gate mode that is 
selected.

I^ or (I/) Position of the signal peak value in gate I (or crossing point in gate I). 
The measurement taken depends on the gate mode that is selected.

AdBr Difference between the current amplitude in gate A and the 
reference amplitude (in dB).

A%r Difference between the current amplitude in gate A and the 
reference amplitude (in %).

AdBA Difference between the current amplitude in gate A and the current 
threshold of gate A (in dB).
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Table 50  Positioning reading code descriptions 

Category Description

PA^ Distance on the part surface between the wedge (or probe) front 
face and the indication detected in gate A.

PB^ Distance on the part surface between the wedge (or probe) front 
face and the indication detected in gate B (see the PA^ definition).

DA^ Depth in the part of the reflector producing the indication detected 
in gate A.

DB^ Depth in the part of the reflector producing the indication detected 
in gate B.

SA^ Sound path from the part entry point to the indication detected in 
gate A.

SB^ Sound path from the part entry point to the indication detected in 
gate B.

VsA^ Volumetric position of the indication detected in gate A in relation 
to the scan axis.

VsB^ Volumetric position of the indication detected in gate B in relation 
to the scan axis.

ViA^ Volumetric position of the indication detected in gate A on the 
index axis.

ViB^ Volumetric position of the indication detected in gate B on the 
index axis.
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Figure 2-65  Diagram of the PA, DA, ViA, and VsA readings

2.12.3 Cursor Category Readings

Table 51 on page 115 shows the Cursor category reading codes and their descriptions.

Table 51  Cursor reading code descriptions 

Category Description

%(r) Amplitude value at the reference-cursor position.

%(m) Amplitude value at the measurement-cursor position.

%(m-r) Amplitude value obtained by subtracting the amplitude of the 
reference cursor from the amplitude of the measurement 
cursor.

U(r) Position of the reference cursor on the ultrasound axis.

U(m) Position of the measurement cursor on the ultrasound axis.

U(m-r) Distance along the ultrasound axis, obtained by subtracting the 
position of the reference cursor from the position of the 
measurement cursor.

S(r) Position of the reference cursor on the scan axis.

Scan axis
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S(m) Position of the measurement cursor on the scan axis.

S(m-r) Distance along the scan axis, obtained by subtracting the 
position of the reference cursor from the position of the 
measurement cursor.

I(r) Position of the reference cursor on the index axis.

I(m) Position of the measurement cursor on the index axis.

I(m-r) Distance along the index axis, obtained by subtracting the 
position of the reference cursor from the position of the 
measurement cursor.

I•U(m-r) Distance along the diagonal of the rectangle formed by the 
intersection of the measurement and the reference cursors.

TOFD(r) Corresponding depth in the part along the ultrasound axis for 
the reference cursor (calibrated TOFD group only).

TOFD(m) Corresponding depth in the part along the ultrasound axis for 
the measurement cursor (calibrated TOFD group only).

TOFD(m-r) Corresponding depth in the part along the ultrasound axis, 
obtained by subtracting the depth of the reference cursor from 
the measurement cursor (calibrated TOFD group only).

D(r) Corresponding depth in the part along the ultrasound axis for 
the reference cursor.

D(m) Corresponding depth in the part along the ultrasound axis for 
the measurement cursor.

I•D(m-r) Corresponding depth in the part along the ultrasound axis, 
obtained by subtracting the depth of the reference cursor from 
the measurement cursor.

S(m-r) CSC Scan distance between the reference and measurement cursors, 
corrected for the part curvature and flaw depth.

%(U(r)) Amplitude of the signal at the position of the reference cursor 
on the ultrasound axis. For TOFD group only.

Table 51  Cursor reading code descriptions (continued)

Category Description
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2.12.4 Corrosion

 Table 52 on page 117 shows the Corrosion category reading codes and their 
descriptions.

%(U(m)) Amplitude of the signal at the position of the measurement 
cursor on the ultrasound axis. For TOFD group only.

Table 52  Corrosion reading code descriptions

Category Description

T(x) T is a dynamic reading used to measure thickness. Thickness 
can be measured using one gate or subtracting two gate values, 
so x will change according to the Thickness Mode selected.

ML Material loss, expressed in percentage (%), is the part thickness 
minus the value in the T reading divided by the part thickness.

Tmin The thinnest reading recorded during the current acquisition.

S(TminZ) The scan axis position of the Tmin reading.

I(Tmin) The index axis position of the Tmin reading.

Angle(Tmin) The relative focal law or virtual probe aperture (VPA) of the 
Tmin reading.

TminZ The thinnest reading recorded within the zone created by the 
reference and measurement cursors of the thickness C-scan 
display.

S(Tmin) The scan axis position of the TminZ reading.

I(TminZ) The index axis position of the TminZ reading.

Angle(TminZ) The relative focal law or virtual probe aperture (VPA) of the 
TminZ reading.

Table 51  Cursor reading code descriptions (continued)

Category Description
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2.12.5 Immersion

 Table 53 on page 118 shows the Immersion category reading codes and their 
descriptions.

2.12.6 Sizing

 Table 54 on page 118 shows the Sizing category reading codes and their descriptions.

Table 53  Immersion reading code descriptions

Category Description

I/ Position of the signal when it crosses the gate I. The measurement 
taken depends on the gate mode.

I(w)/ Position of the signal when it crosses the gate I, using the velocity 
of water.

Table 54  Sizing reading code descriptions

Category Description

A%Curve Difference, in percentage, between the peak amplitude in gate A 
and the corresponding amplitude of the selected sizing curve.

AdbCurve Difference, in dB, between the peak amplitude in gate A and the 
corresponding amplitude of the selected sizing curve.

B%Curve Difference, in percentage, between the peak amplitude in gate B 
and the corresponding amplitude of the selected sizing curve.

BdbCurve Difference, in dB, between the peak amplitude in gate B and the 
corresponding amplitude of the selected sizing curve.

ERS Equivalent reflector size used with the DGS.

Hardness 
Depth

Measured within the area of the gate in the active End View. It 
indicates the depth at which the difference between the upper 
and lower sections in the gate is maximal. Available only in PCI 
and OmniScan X3 64.
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2.12.7 Generic Reading Codes

Table 55 on page 119 shows the Generic reading codes that appear when abnormal 
conditions occur and no value can be displayed.

AdBCurveG Difference, in dB, between the peak amplitude of the signal 
detected in gate A, and the corresponding amplitude of the 
selected sizing curve. The reading will react to changes in Gain 
Offset.

A%CurveG Difference, in percentage, between the peak amplitude of the 
signal detected in gate A, and the corresponding amplitude of 
the selected sizing curve. The reading will react to changes in 
Gain Offset.

BdBCurveG Difference, in dB, between the peak amplitude of the signal 
detected in gate B, and the corresponding amplitude of the 
selected sizing curve. The reading will react to changes in Gain 
Offset.

B%CurveG Difference, in percentage, between the peak amplitude of the 
signal detected in gate B, and the corresponding amplitude of the 
selected sizing curve. The reading will react to changes in Gain 
Offset

Table 55  Generic reading code descriptions 

Category Description

ND No signal detected. This code appears when no signal has crossed 
the gate.

- - - No data acquired. This code appears if any portion of the scan area 
was not covered during the inspection.

NS No synchronization. This code appears when a gate is synchronized 
with another gate (or synchronization gate), but the synchronization 
cannot be established because no signal has crossed the 
synchronization gate.

Table 54  Sizing reading code descriptions (continued)

Category Description
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2.13 Rulers/Scales

Rulers/scales on the vertical or horizontal sides of the data views are associated with 
various axes. Figure 2-66 on page 120 provides an example of multiple views with 
rulers/scales.

Figure 2-66  Example of multiple views with various rulers/scales

Table 56  Rulers/scales multiple views

Item 
number Description

1  Amplitude axis

2 Color palette ruler/scale

3 Index axis

① ②

③④⑤
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Each ruler/scale is filled with a dedicated color to help you identify the axis on the 
various views. Figure 2-67 on page 121 provides examples of rulers/scales with colors 
and functions.

A basic color is attributed to each axis. The axis appears in various tints of this basic 
color. The lightest tint corresponds to the raw data representation. Progressively 
darker tints correspond to increasing data correction complexity relative to the axis. A 
darker tint is also used for an axis that appears as a reference, in which case, the zoom 
bar is not available.

 

Figure 2-67  Examples of rulers/scales

4 Ultrasound axis

5 Angle axis

Table 56  Rulers/scales multiple views (continued)

Item 
number Description

Scan — no zoom

Scan — volumetric

Scan

Index — volumetric

Index

Amplitude

UT true depth

UT sound path

UT time

TOFD wave synchronization

TOFD

Group

Angle — VPA

Time
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2.14 Operation Modes

The OmniScan X3 flaw detector features two modes: inspection mode and analysis 
mode. Figure 2-68 on page 122 illustrates the basic operations of each mode and 
switching between modes.

Figure 2-68  Inspection and analysis mode functions

2.14.1 Inspection Mode

Inspection mode is the default acquisition mode when the OmniScan X3 flaw detector 
is turned on. Inspection mode has the following characteristics:

• The instrument continuously produces ultrasonic beams and dynamically 
displays ultrasonic data.

• Pressing the Play key () starts data recording for a scanned area (using an 
encoder) or for a predetermined period of time.

• Pressing the Pause key () pauses the data acquisition and activates analysis 
mode.

Inspection mode
• See dynamic ultrasonic data.
• Acquire data over time or by using an encoder.
• Save the setup file (.oset)

Analysis mode
• Review acquired ultrasonic data.
• Add indication to the indication table.
• Build and save a report (.html, .zip, .pdf).
• Save the data file (.odat).

Press the Pause key () to switch between modes
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2.14.2 Analysis Mode

Analysis mode is used to analyze recorded data after an inspection. Analysis mode 
has the following characteristics:

• The instrument stops acquiring data, and the recorded data is available for 
analysis.

• The acquisition indicator illuminates solid orange.

2.15 Outline Colors on Parameter Buttons

In certain submenus, some or all of the parameter buttons are outlined in colors that 
indicate the interface element to which the parameter applies.

There are three colors, each referring to specific gate:

• Red: The parameter applies to gate A.
• Green: The parameter applies to gate B.
• Yellow: The parameter applies to gate I.

2.16 Compression (TOFD Only)

The Compression feature is available (see Figure 2-69 on page 124) to support 
corrosion mapping and composite inspection applications.

Compression is included on the B-scan and C-scan to ensure that the most relevant 
information in a pixel is displayed at all times. For an amplitude C-scan or B-scan, the 
pixel color is determined by the data point of highest amplitude. For a time-of-flight 
or position C-scan, the pixel color is determined by the data point of shortest time-of-
flight (thinnest). If the inspected area has more data points than pixels, the 
Compression feature will be turned on automatically in order to select which data 

will be displayed for each pixel, and the “C” icon ( ) is displayed on the status 
indicator.

If a zoom is performed on the C-scan, and all the data points are displayed, the 
Compression symbol and the Compression indicator will no longer be displayed. This 
function is always active, and does not require configuration.

C
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Figure 2-69  Compression example

2.17 High Definition (PA-UT Only)

The High Definition “HD” icon ( ) (see Figure 2-70 on page 125) feature indicates 
that each point of data is represented by at least one pixel. A larger scan area may 
contain too many data points to be represented by one pixel, so a compression will be 
applied (keeping the maximum amplitude) and the HD icon will not be displayed.

This icon may appear by zooming on a section. If the HD icon appears, it means that 
all the data points are represented in the view and are not compressed.

C
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Figure 2-70  High definition example (PA-UT only)

2.18 Shortcuts

Some operations that are done frequently have a shortcut available directly in the 
views. To access the shortcut, tap and hold (right-click) on the screen to view the list of 
shortcuts.

Table 57  Shortcuts 

View Shortcut name Description

All Set Reference 
Cursor

Positions the cursor where you tapped.
This is a shortcut for Measurements > 
Cursors.

Set 
Measurement 
Cursor

Positions the cursor where you tapped.
This is a shortcut for Measurements > 
Cursors.
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A-scan Enable/Disable 
Envelope

Turns ON or OFF the A-scan envelope, 
which keeps track of the maximum 
amplitude recorded at each position in the 
A-scan.

Clear Envelope Only available when the envelope is ON. 
This resets the envelope.

Enable/Disable 
A-scan Synchro

Available when the group type is 0° with 
overlap. Turns ON or OFF the A-scan 
synchronization on gate I.

S-scan Index Offset Modifies the Index Offset directly without 
going to Probe & Part > Position.

Skew Left (90°) Flips the probe orientation.

Skew Right 
(270°)

Flips the probe orientation.

Set Data Cursor Selects the focal law where you tapped.

C-scan A%, B%, I%, I/ Depending on which gates are active, these 
shortcuts may or may not be available.
Changes the data source of the C-scan.

Scan Offset Modifies the Scan Offset directly without 
going to Probe & Part > Position.

Set Data Cursor Selects the focal law where you tapped.
This is a shortcut for Measurements > 
Cursors.

Table 57  Shortcuts (continued)

View Shortcut name Description
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Figure 2-71  Shortcuts menu example

B-scan Activate 
Merged B-Scan

Changes the B-scan display to a merged B-
scan.

Scan Offset Modifies the Scan Offset directly without 
going to Probe & Part > Position.

Set Data Cursor Selects the focal law where you tapped.
This is a shortcut for Measurements > 
Cursors.

Top or side 
view

Scan Offset Modifies the Scan Offset directly without 
going to Probe & Part > Position.

Any ruler Zoom Out Resets the zoom.

Table 57  Shortcuts (continued)

View Shortcut name Description
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2.19 Export — OmniPC Software

In OmniPC software, there is an additional shortcut available. Right-clicking in a C-
scan or a B-scan displays the option Export C-scan (when in a C-scan) or Export All 
A-scans (when in a B-scan) option. When you click Export, a .txt file is created in 
C:\Users\%USERNAME%\Documents\OlympusNDT\OmniPC\Export.

The exported file has the same name as the data file used for the export, with the 
current timestamp added. The data is structured as indicated in Table 58 on page 128.

Table 58  Exported file data structure

Data File = Data file name

Inspection Date = Date when the file was saved

Group = Name of the exported group

Focal Law = Law configuration (sectorial, linear, etc.)

Type = For an exported B-scan, this line says A-scan. For an exported C-
scan, the line says C-scan and the type of C-scan (A Amplitude, B 
Amplitude, Thickness, etc.)

ScanStart = First position in the scan axis

Scan Qty = Number of scan positions

Scan Resol. = Distance between each scan line

IndexStart = First Angle/VPA

Index Qty. = Number of index positions

Index Resol. = Distance between each index position

USound Start = UT Start

USound Qty. = Point Quantity

USound Resol. = Distance between each A-scan point

Ampl. Min. (%) = 0

Ampl. Max. (%) = 800 or 200

Ampl. Resol (%) = Data resolution in the amplitude axis
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For an exported B-scan, the data is structured (see Table 59 on page 129) as follows:

For an exported C-scan, the data is structured (see Table 60 on page 130) as follows: 

Gate Start (mm) = For a C-scan, beginning of the gate 

Gate Length (mm) = For a C-scan, width of the gate 

Gate Level (%) = Gate Threshold

Bit Depth = 16

Thickness Resol. (mm) = Resolution for a thickness C-scan

Min Thickness (mm) = Minimum thickness of the scale

Max Thickness (mm) = Maximum thickness of the scale

Data Table

Table 59  B-scan Export

Position (not 
shown in file) Data in the file

Scan 0, Index 0 A-scan point 1 A-scan point 2 ... A-scan point last

Scan 1, Index 0 A-scan point 1 A-scan point 2 ... A-scan point last

Scan..., Index 0 A-scan point 1 A-scan point 2 ... A-scan point last

Scan last, Index 0 A-scan point 1 A-scan point 2 ... A-scan point last

Scan 0, Index 1 A-scan point 1 A-scan point 2 ... A-scan point last

Scan 1, Index 1 A-scan point 1 A-scan point 2 ... A-scan point last

Scan..., Index 1 A-scan point 1 A-scan point 2 ... A-scan point last

Scan Last, Index 1 A-scan point 1 A-scan point 2 ... A-scan point last

Scan 0, Index 2 A-scan point 1 A-scan point 2 ... A-scan point last

Table 58  Exported file data structure (continued)
OmniScan Interface 129



10-001244-01EN, Rev. 13, April 2024
Table 60  C-scan Export

Units Scan 0 Scan 1 Scan 2 ... Scan End

Index End C-scan data C-scan data C-scan data C-scan data

... C-scan data C-scan data C-scan data C-scan data

Index 2 C-scan data C-scan data C-scan data C-scan data

Index 1 C-scan data C-scan data C-scan data C-scan data

Index 0 C-scan data C-scan data C-scan data C-scan data
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3. Scan Plan

The Scan Plan wizard is used to create or modify the required parameters for 
inspecting a part.

Select Main menu, >  Plan & Calibrate > Scan Plan to create a complete setup 
for your application (see Figure 3-1 on page 132). The Scan Plan contains these main 
tabs:

• 1 PART & WELD
• 2 PROBES & WEDGES
• 3 GROUPS
• 4 SCANNING

After setting parameters on the first tab, and going through the numbered substeps, 
tap the second tab to continue the Scan Plan wizard (see Figure 3-1 on page 132). 

You can exit the Scan Plan wizard menu at any time by tapping Done at the top right 
of the screen.

TIP
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Figure 3-1  Scan Plan tabs, numbered substeps

3.1 Part & Weld Tab

Use the PART & WELD tab to define the material, geometry, and weld for the part. 
Depending on the selected Part Category, up to four substeps are displayed to refine 
the part definition.
Chapter 3132



10-001244-01EN, Rev. 13, April 2024
Figure 3-2  Scan Plan > Part & Weld > Substep 1

3.1.1 Part and Weld Substep 1 

In substep 1, select the Part Category (see Figure 3-2 on page 133).

• Simple Geometry (No Weld)
• Simple Welded Joints
• Custom Part

Table 61  Part & Weld substep 1

Option Description

Part Category Simple Geometry (No Weld): Choose between 
Flat Plate, Pipe / Tube, and Curved.
Simple Welded Joints: Choose between Flat Weld, 
Axial Weld, Circ. Weld, and Girth Weld.
Custom Part: Flat Plate

Dimensions Sets dimensions according to the Type of part 
selected.
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3.1.2 Part and Weld Substep 2

Figure 3-3  Scan Plan > Part & Weld > Substep 2

Figure 3-4  Part reference example

Axis Reference
[100, 39.3]

Datum 
[0,0]
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In substep 2, select the MAIN MATERIAL, define the Part REFERENCE relative to 
DATUM, and define the AXIS Direction and Name (see Figure 3-3 on page 134 and 
Figure 3-4 on page 134).

Table 62  Part & Weld substep 2

Option Description

Material MAIN MATERIAL: Choose the material of the inspected part 
from the list (it is set to Steel, Mild by default).
Longi. Velocity: Velocity of the longitudinal wave in the 
material. This value is automatically set when you choose the 
Material. This value can be edited manually.
Shear Velocity: Velocity of shear waves in the material. This 
value is automatically set when you choose the Material. This 
value can be edited manually.
Part REFERENCE Relative to DATUM: Set the Primary and 
Secondary Axis Reference distance.
AXIS Direction and Name:   Assign different names to the 
Primary and Secondary axes.
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3.1.3 Part and Weld Substep 3

Figure 3-5  Scan Plan > Part & Weld > subtep 3

In substep 3, specify the joint type using the Weld Template and Symmetry Type 
parameters (see Figure 3-5 on page 136).

Figure 3-6  Custom part substep 3
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 Substep 3 for Custom part provides various options to adjust a custom overlay on the 
part (see Figure 3-6 on page 136 and Table 64 on page 138).

Table 63  Part & Weld substep 3

Option Description

Simple 
Welded 
Joints

Select a Weld Template: V, V-Offset, Double V, Double 
V-Offset, J, or U.
Select the Symmetry Type: Symmetric, Flat-Left, or Flat-
Right.

Custom Part Import .dxf: Used to load a .dxf file containing the custom 
overlay. The file must have already been transferred using the 
File Manager.
PART GEOMETRY:   Use Scale to part to constrain to the set 
part dimensions.
DRAWING ADJUSTMENT: Used to modify the scale, 
rotation and position of the drawing. You may also flip the 
drawing and reset the original dimensions and position.
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3.1.4 Part and Weld Substep 4

Figure 3-7  Scan Plan > Part & Weld > substep 4

In substep 4, specify additional weld properties (see Figure 3-7 on page 138).

Table 64  Part & Weld substep 4

Option Description

Weld 
properties

Set the weld properties:
• Fill
• Hot Pass
• Land
• Root
• Upper and Lower Cap
• HAZ
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3.2 Probes & Wedges Tab

Use the PROBES & WEDGES tab to define the probes and wedges used for the 
inspection (see Figure 3-8 on page 139). At the top, set the different physical 
connections (up to eight). On the right, set the probe and wedge configuration related 
to the selected group.

You also need to select a predefined wedge or define the wedge that you want to use 
for your inspection.

Figure 3-8  Scan Plan > Probes & Wedges

Figure 3-9  Add connected probe dialog
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Table 65  Probes & Wedges options 

Option Description

Connection Setup Add: Add a new probe and assign a connector from the 
following list: 
• PA: Phased array probe assigned on the PA 

connector.
• UT on PA: UT probe assigned on the PA connector 

(typically with the use of a splitter).
• UT on P1R1 / UT on P2R2: UT probe assigned on 

the UT connectors. The pairs are independent.
Clone: Used to create a copy of an existing probe and 
wedge configuration.

Type PA: PA Linear, PA Linear Pitch-Catch, PA Dual, Dual 
Linear 0°
UT: TOFD, Pulse-Echo, Dual UT, Pitch-Catch.

Probe Probe selection based on the Probe & Wedge library.

Detect probe Use this button to detect the probe connected to the 
instrument. If the probe is not part of the database, it 
can be added as a custom probe. See Figure 3-9 on 
page 139.

Wedge Wedge selection based on the Probe & Wedge library.

Wedge Profiler Use this button to launch the Wedge Profiler 
(see “Wedge Profiler” on page 143).

Pulser PA: Used to choose the first pulser of the probe. For a 
single probe on the PA connector, the Pulser value 
should be 1. The Pulser value should be higher when 
configuring the second probe on a splitter (according to 
the splitter wiring).
UT: Displays the UT connector if selected, or enables 
you to edit the pulser value if a splitter is used in a UT 
on PA configuration.
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Receiver Displays the receiver that is set according to the probe 
configuration and the Pulser value. The Pulser value 
can be edited only in a UT on PA with Dual UT probe 
configuration.

 Used to set the scan offset of the selected probe.

 Used to set the index offset.

Used to set the distance between the probes in a Pitch-
Catch configuration.

 Used to flip the skew to either 90 or 270.

 Tap to display the top view of the 3D viewer.

 Tap to display the front view of the 3D viewer.

 Tap to display the side view of the 3D viewer.

 Tap to display the perspective view of the 3D viewer.

 Tap to display the wedges or only the one selected.

Deletes the current probe.

Table 65  Probes & Wedges options (continued)

Option Description
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Figure 3-10  Scan Plan > Probes & Wedges > Add — Probe selection example

If your probe or wedge is not available in the predefined list, you can define a new 
one by clicking the Probe & Wedge Manager button (see “Probe & Wedge Manager” 
on page 197). 

For PA probes, use the Probe & Wedge Manager to add custom probes or wedges, 
which is located outside the Scan Plan. For UT probes, you can also use the Probe & 
Wedge Manager, but a quick probe and wedge editor is available if the Unknown 
probe or wedge is selected. A combination of a custom (unknown) probe with a 
wedge from the list is also possible. When selected from the list, the probe or wedge 
parameters are fixed, but choosing the Unknown option enables you to edit the 
parameters (see Table 66 on page 143).

TIP
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In phased array mode, only the wedges that are dedicated to the probe are available 
by default. The list of dedicated wedges speeds up the wedge selection process. 
However, if you need to view the complete list, you can use the Show Dedicated / 
Show All button to toggle between the full and the dedicated lists of wedges.

3.2.1 Wedge Profiler

The Wedge Profiler is used to empirically validate and adjust the parameters of a 
wedge. The resulting new parameters are automatically applied to the focal law 
calculation. 

The Wedge Profiler becomes available once a valid probe and wedge combination has 
been selected (see Figure 3-11 on page 144). The wedge profiler can be used for all PA 
linear probes (FLAT, AOD, and COD) for all available part types. 

Table 66  New probe & wedge options

Option Description

Frequency The probe frequency used to calculate the default pulse 
width and visualization of the dead zone in TOFD.

Diameter If the selected probe is Unknown, the Diameter 
parameter is editable and used primarily for 
visualization. The probe is assumed to be circular (for a 
custom-square probe, use Probe & Wedge Manager).

Refracted Angle The refracted angle in the material. Snellʹs law is used to 
draw the angle of the wedge.

Wedge Travel The distance between the probe surface and the beam 
exit point.

Velocity Velocity of the wedge material.

Reference Point See Figure 6-7 on page 200 (UT wedge reference point).

NOTE
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Figure 3-11  Probe and Wedge selection

The Wedge Profiler opens a calibration screen that displays the S-scan of a linear 
group with an element quantity of 1. The resulting display shows the detected wedge 
interface.

The A gate is active and is used to select the interface signal. 

The Gain can be changed as needed to adjust the amplitude of the interface response. 

The Measure button initiates the wedge profile, which recalculates the wedge angle 
and first element height (See Figure 3-12 on page 145 and Table 67 on page 145).
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Figure 3-12  Wedge Profiler calibration

After the wedge parameters have been measured, the signal is redisplayed, but with 
the beam delays so that the wedge interface is horizontal in the S-scan.

Table 67  Wedge Profiler options

Option Description

Gain Modify the gain of the signal.

Range Modify the A-scan range.

Start Modify the A-gate start.

Width Modify the A-gate width.

Measure Measure the wedge dimensions from 
the signal in the A-gate.
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The expected position of the interface is displayed with a dotted green line for visual 
comparison. You can make manual adjustments to the first element height and wedge 
angle to correct any remaining deviation.

The new values can be accepted and applied to the setup by pressing Accept Profile, 
or the nominal values can be reset with the Reset to Nominal button (see Figure 3-13 
on page 146).

Figure 3-13  Measurement adjustment

Table 68  Wedge Profiler validation options

Option Description

Reset to 
Nominal

The original wedge measurements can be restored with this button.

Accept Profile Accept and replace the nominal values with those that have been 
measured using the Wedge Profiler.
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In the case of a COD wedge, you can also adjust the diameter of the wedge interface 
manually after the angle and elements’ heights have been detected. The same green 
dotted line can be used to align the wedge interface. 

The gap between the nominal and user defined interface cannot be edited directly, but 
will update when the diameter is changed manually (see Figure 3-14 on page 148).

Angle Displays the measured wedge angle and enables you to manually edit 
the angle.

Height Displays the measured first element height and enables you to manually 
edit the height.

Adjust Applies the manually edited settings to calculate new delays.

Restore Setup Reapplies the wedge configuration that was saved in the setup after a 
measurement has been completed, even if they are different than the 
nominal values.

Done Confirms the wedge values and exits the Wedge Profiler.

Diameter 
(COD only)

Enables you to manually edit the wedge diameter.

Table 68  Wedge Profiler validation options (continued)

Option Description

NOTE
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Figure 3-14  Measurement validation

If calibrations have been done beforehand in a new or previously saved setup, the 
wedge profile can still be confirmed by resetting the nominal values and measuring 
the wedge. 

After the values have been remeasured, you can accept the new values or restore the 
previous setup.

If the new values are accepted, any previous calibrations will be reset. The reset 
applies to calibrations done with nominal values or previously saved values.

NOTE
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3.3 Groups Tab

On the GROUPS tab, the groups are defined based on the probe configuration 
defined previously. One group per probe is created by default, which you can edit 
using the menu on the right side. To create more than one group on a probe, use the 
Add or Clone button. A group is a set of beams, or focal laws, defined by the Law 
Config.

Figure 3-15  Scan Plan > Groups

The parameters for each group can have multiple pages, which you can scroll through 
using the Previous and Next buttons at the bottom right of the screen (see Figure 3-16 
on page 150 and Table 69 on page 150).
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Figure 3-16  Scan Plan > Groups > Law Config. parameters

It is not possible to have fewer than one or more than eight groups. The maximum 
number of focal laws is 1024. Each defined probe must have at least one group 
assigned. Some configurations, such as 0° with overlap, allow only one group. 
Therefore if more than one probe or group is defined, these configurations will not be 
available.

Table 69  Groups — New Set — Configuration options 

Option Description

GR-1 Used to set the name of the group.

NOTE
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Law Config. 
PAUT

Sectorial: Provides a multiple-angle scan using the same 
elements for every angle of the scan.
Linear: Provides a linear scan at a configurable angle. You can 
use this mode at a zero-degree angle if you do not need 
overlapping scans.
Compound: Provides a multiple-angle scan using different 
elements (with the same aperture across the length of the 
probe) for every angle of the scan. Use an element quantity 
smaller than the total number of elements in the probe to 
obtain the benefits offered by this scan type compared with the 
Sectorial scan.
Coupling Check: Provides a single beam firing at 0° in the 
material to validate the coupling. This group has a built-in 
configuration that sends a signal to the I/O connector if the 
amplitude in gate A drops below the threshold.
Law file: Loads a custom .law file that configures the PA 
connector. Supported .law files include versions 5.0, 5.2, and 
5.3.
0° with overlap: Provides a linear scan at 0°. Used primarily for 
raster scanning with some overlap between each scan line. This 
group can only be used alone.
See Figure 3-17 on page 154.

Law Config. 
FMC

TFM: Provides a TFM scan over the selected area based on a 
reconstruction of the FMC acquired data. The TFM scan uses 
all elements of the probe.
PCI: Uses a similar algorithm to the standard TFM, but instead 
of summing amplitude elementary A-scans, it sums the phase 
of those elementary A-scans.
See Figure 3-17 on page 154.

Table 69  Groups — New Set — Configuration options (continued)

Option Description
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Law Config. 
PWI

See “Plane Wave Imaging (PWI)” on page 211.
TFM: Provides a TFM scan over the selected area based on a 
reconstruction of the PWI acquired data. The TFM scan uses all 
elements of the probe.
PCI: Uses a similar algorithm to the standard TFM, but instead 
of summing amplitude elementary A-scans, it sums the phase 
of those elementary A-scans.
See Figure 3-17 on page 154.

Wave Type Used to set the toggle between LW and SW.
LW: Longitudinal wave
SW: Shear wave

Elements First: Displays the first element on the probe.
Last: Displays the last element on the probe.
Quantity: Used to set the number of elements used in the focal 
law (the size of the aperture). For a M × N matrix array probe, 
element quantity can only be a multiple of M, the number of 
elements in the primary axis.
Step: Used to set the spacing between the consecutive focal 
laws (for linear scans and zero-degree law configuration).

Table 69  Groups — New Set — Configuration options (continued)

Option Description
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Law 
Configuration: 
(Sectorial)

Angle Start: Used to set the angle of the first beam in the 
material.
Angle Stop: Used to set the angle of the last beam in the 
material from the wedge.
Angle Step: Used to set the angular step between each focal 
law.
Skew Angle: Used to steer the beam angle (matrix probes 
only).
Focusing Type:

• True Depth: The focus is at the same depth for all 
beams.

• Half Path: The focus is at the same sound path for all 
beams.

• Projection: The focus is at a set distance from the edge 
of the probe at the defined angle.

• Unfocused: The beam is not focused at any point.
Focus depth: Used to set the focusing depth.

Law 
Configuration: 
(TFM)

Wave Set: Switch between Pulse Echo or Self Tandem to 
display the different wave set options for each mode. Choose 
the wave set that best fits the inspection. Appropriate wave set 
selection is crucial for a good TFM inspection. Use the AIM to 
facilitate wave set selection. See “Groups — View Menu” on 
page 154 and Figure 3-18 on page 155.
Min/Max Index: Used to set the limits of the TFM zone in the 
index axis.
Min/Max Depth: Used to set the limits of the TFM zone in the 
depth axis. The Maximum Depth is currently limited to the 
depth of the sample.

Table 69  Groups — New Set — Configuration options (continued)

Option Description
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Figure 3-17  Groups—Law Config.

3.3.1 Groups — View Menu

Use these settings to modify the visual representation of the scan plan. The View 
menu items change depending on the display type.

Focusing 
(TOFD)

PCS: Used to set the probe center separation (PCS). This is the 
distance between the exit points of the two probes.
Focus (%): Used to set the focus in depth of the beam in 
percentage (%) of the thickness.
Focus (mm/inch): Used to set the depth of the focus of the 
beam. Focus can be input in percentage or distance; changing 
one recalculates the other.

Table 69  Groups — New Set — Configuration options (continued)

Option Description
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Figure 3-18  Groups —View menu in FMC and PWI displays

Table 70  Groups —View menu in FMC and PWI displays

Option Description

View — Specimen You can toggle between Show and Hide.

View — Acoustic Influence Map Without impacting the acoustic configuration, 
you can use this option to select the defect 
type in the AIM tool (Spherical or Planar). 
Selecting the appropriate defect type in the 
AIM model helps ensure you select the proper 
Wave Set. 

View — Attenuation AIM attenuation can be turned ON or OFF.
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Figure 3-19  Groups —View menu in sectorial display

3.3.2 Near field calculation

The near field value is calculated using formula (1) on page 157. 

Variables are defined in Table 72 on page 157. 

To calculate the near field (Nf) value,

Table 71  Groups —View menu in sectorial display

Option Description

View — Specimen You can toggle between Show and Hide.

View — Near Field Display Show or Hide the near field display, which 
appears in red in the visual representation. 
See “Near field calculation” on page 156.

View — Reference Beam Show or Hide the reference beam, which 
appears as a yellow line.

Annotations Display or hide the annotations.
 Axis Direction and Name
 Part Reference relative to Datum
 Group Name
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Nf = h × A2 × f / (4 × c2) (1)

To calculate near field in specimen (Np) value

If Nf - rv ≥ 0, use

Np = Nf - rv

If Nf - rv < 0, use

Np = - (A2 × f) / (4 × c2) (2)

If the near field value Np is negative, the near field is located in the wedge and is 
assigned a negative value. In this case, we use formula (2) on page 157.

Table 72  Near field formula variables 

Variable Description Units

f Probe frequency Hz

N Number of probe elements -

wedgeAngle Wedge Angle rad

θr Refraction angle rad

θi Incidence angle rad

L Probe length m

W Probe width m

A Transducer aperture dimension m

E Elevation m

p Probe pitch m

h Correction coefficient -

rw Wedge sound path length m

NOTE
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The value of the different variables are calculated with the provided equations.

Transducer aperture (A):

L = 0.95p × N 

W = 0.95 × E 

Where 0.95 is the apodization value.

If L × cos(wedgeAngle - θi) ≥ W, use

A = L × cos(wedgeAngle - θi) × cos(θr) / cos(θi)

Else,

A = W

Correction coefficient (h)

h = 0.6546 × ratio3 – 0.3112 × ratio2 + 0.0411 × ratio + 0.9987

Where:

If A = W

ratio = W/A

If A < W

ratio = A/W

rv Adjusted wedge sound path length m

c1 Wedge sound speed m/s

c2 Probe sound speed m/s

Nf Near field value m

Np Near field value in specimen m

Table 72  Near field formula variables (continued)

Variable Description Units
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Wedge sound path length (rw)

Variable rw is obtained by measuring the distance between the entry point of the ray 
into the specimen and the centroid of the central element of the active aperture. 

For an even number of elements in the active aperture, calculate the distance between 
the entry point of the ray in the specimen and the mid point between the centroid of 
the two central elements of the active aperture.

Adjusted wedge sound path length (rv)

If the refraction angle θr ≠ 0 rad,

rv = rw × tan(θi) / tan(θr)

If θr = 0 rad

rv = rw × c1 / c2

3.4 Scanning Tab

Figure 3-20  Scan Plan > Scanning
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On the SCANNING tab, you can define the Scanning Pattern and Scan Area 
parameters by changing the Scan Axis and Index Axis values. You can also select and 
edit encoder parameters (see Figure 3-20 on page 159).

See Table 73 on page 160 for a description of the options.

Table 73  Scan — Area 

Option Description

Scan Start Used to set the starting location of the scan (expressed in 
mm or in.).

Scan End Used to set the maximum distance you can scan (expressed 
in mm or in.).

Scan Res. Used to set the step (resolution) at which the points will be 
acquired on the scan (expressed in mm or in.).

Index Start (Raster scan only.) Used to set the starting location of the 
raster scan in the index axis (expressed in mm or in.).

Index End (Raster scan only.) Used to set the raster end location in the 
index axis (expressed in mm or in.).

Index 
Res./Index 
Step

(Raster scan only.) Determines the index resolution. Cannot 
be modified in the Linear at 0° scan.
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4. Calibration

Depending on your requirements, before starting an inspection, you can perform 
several calibration procedures using a probe, wedge, and calibration block composed 
of the same material as the part to be inspected.

To perform a calibration

1. Select  >  Plan & Calibrate > Calibration Tools to access the PA/UT/TFM 
Calibration wizard (see Figure 4-1 on page 162). See “TOFD Calibration” on 
page 180 to perform a TOFD calibration. Like the Scan Plan wizard, the 
Calibration wizard’s workflow is separated into several tabs or sections (for 
different types of calibration).

2. On the Group tab (see Figure 4-1 on page 162), select the group you wish to 
calibrate. For a UT group, also choose the sizing method to calibrate: TCG, DAC, 
or DGS. 

3. Navigate through the other tabs to calibrate the group. On each tab after the 
Group tab, the calibration parameters are on the right and the views are on the 
left.

4. Set your parameters, then move your probe to adjust the signal according to the 
calibration type. 

5. Subsequently tap either Get Position or Calibrate. When you are satisfied with 
your adjustment, tap Accept Calibration.

6. You can then either continue to another tab in the Calibration wizard, or exit by 
tapping Done.
Calibration 161



10-001244-01EN, Rev. 13, April 2024
Figure 4-1  Calibration > Group

If an ultrasonic velocity calibration and a wedge delay calibration are required, 
perform the ultrasonic velocity calibration before the wedge delay calibration. The 
OmniScan X3 flaw detector uses the ultrasonic velocity determination for the wedge 
delay calibration. If you attempt to calibrate the wedge delay first, you will receive a 
message warning you that the wedge delay calibration will be lost when you perform 
the ultrasonic velocity calibration.

You can exit a Calibration wizard at any time by pressing the Cancel key (). When 
exiting the wizard, the signal goes back to its original state (as it was before the 
calibration).

IMPORTANT

TIP
Chapter 4162



10-001244-01EN, Rev. 13, April 2024
The Calibration indicators (icons) turn green after calibration (see Table 5 on page 31).

4.1 Reflector Types

Calibration procedures are performed using calibration blocks with different types of 
known reflectors. Table 74 on page 163 illustrates the types of probes, wedges, and 
calibration blocks used for each type of reflector.

4.2 Ultrasonic Calibration

You can calibrate several ultrasonic aspects using the Calibration wizard.

Table 74  Reflector, probe, and calibration block types 

Reflector type Probe type Probe, wedge, and calibration block

Radius Angle beam

Depth Angle beam

Thickness 0 degree

NOTE

Radius 1

Radius 2

Depth 1
Depth 2

Thickness 1 Thickness 2
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Velocity
Used to calibrate the velocity of the sound propagation in the material of the 
inspected part (see Figure 4-2 on page 164). The calibration block must have two 
known reflectors and be made of the same material as the part to be inspected. 
The Velocity is calibrated along with the wedge delay in one process for UT 
channels. In a UT group, Velocity calibration is performed simultaneously with 
wedge delay calibration.

 To calibrate Velocity:

1. Define the two targets. The maximum distance a target can be set depends on the 
range. Increase the range if needed to reach a target further.

2. Find your target by manually moving the probe over the calibration block.
3. Maximize the signal in gate A, making sure that the most direct path hits the 

target.
4. Hold the position and press Get Position below gate A.
5. Repeat step 3 and 4 for gate B.
6. If the calibration procedure was successful and the velocity seems correct, then 

press Accept. Otherwise, reset the calibration and repeat steps 1 to 6. 

Figure 4-2  Calibration > Velocity
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Sensitivity (PA group only)
Used to calibrate the detection sensitivity for a reference reflector (see Figure 4-3 
on page 165 and Table 75 on page 165). The sensitivity calibration for a PA group 
normalizes the gain for all focal laws to ensure that all focal laws produce a 
similar amplitude signal for the reference reflector. The calibration procedure 
requires a calibration block with one known reflector. 

To calibrate, simply adjust the calibration parameters (display and gates), then 
scan a reference reflector. When all focal laws have scanned the reflector, press 
Calibrate. The envelope signal is used to calculate the amount of gain required 
for each focal law to bring them at the reference amplitude (typically 80 %).

Figure 4-3  Calibration > Sensitivity

Table 75  Sensitivity tab options 

Option Description

Reset Calibration Resets the sensitivity calibration. The “S” at the top of 
the screen disappears.

Clear Envelope Clears the envelope on the bottom view. The green 
line disappears.
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Calibrate Applies a beam gain for each focal law so that the 
amplitude over the reference defect is compensated.

Accept Calibration Accepts and saves the sensitivity calibration. The “S” 
at the top of the screen turns green.

Apply to All Angles/VPA: The calibration applies to all focal 
laws of the group.
2 Angles: The calibration applies to two angles of the 
sectorial scan. The gain for the other angles will be 
interpolated from the calibrated values.
3 Angles: The calibration applies to three angles of 
the sectorial scan. The gain for the other angles will 
be interpolated from the calibrated values.

Set Reference 
Amplitude

Ref. Amplitude: The calibration target (80 % by 
default).
Tolerance: Displays horizontal white and red dotted 
lines at Ref.Amplitude ± Tolerance. Used to check if 
the calibration is within tolerance.

Gate Geometry True Depth: Sets the gate according to the depth in 
the material for the sensitivity calibration.
Sound Path: Sets the gate according to the distance 
traveled in the material for the sensitivity calibration.

Gate A Start: Used to set where the gate starts in reference to 
the origin (can be expressed in mm or in.). The origin 
is either the zero of the ultrasound axis or the 
crossing point of gate I if the current signal is 
synchronized on I/.
Width: Used to set the width (length) of the gate.

UT Settings Gain: Used to set the signal gain value for the 
sensitivity calibration.
Start: Used to set the start of the displayed A-scans.
Range: Used to set the range of the displayed A-
scans.

Table 75  Sensitivity tab options (continued)

Option Description
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You can validate your Sensitivity calibration by clearing the envelope, redoing the 
manipulation, and checking that the amplitude from all focal laws are within 
tolerance.

PA Wedge Delay

Used to calibrate the delay corresponding to the sound propagation within the 
wedge (see Figure 4-4 on page 168 and Table 76 on page 169). A wedge delay 
calibration enables you to identify the face of the wedge contacting the part. This 
establishes a zero position for the entry surface of the part. The calibration 
procedure requires a calibration block with one known reflector.

To calibrate the wedge delay

1. Adjust the UT range and gain to see two (2) reflectors.
2. Set the nominal position of the reflector (in Radius or Depth). 
3. If needed, fine-tune the position of the gates to get the signal inside the gate.
4. Move your probe to maximize the signal in gate A. The chart at the bottom 

displays the position of the maximum amplitude peak in the gate for each focal 
law.

5. After all focal laws have scanned the reflector, press Calibrate. 
6. Press Accept if the results are satisfactory.

Previous
Next

Used to alternate between the parameters on the first 
and second pages.

Table 75  Sensitivity tab options (continued)

Option Description

NOTE
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Figure 4-4  Calibration > Wedge Delay

Velocity & WD (UT group only)
Used to calibrate (with a single wizard) both the sound propagation in the 
material of the inspected part and the delay corresponding to the sound 
propagation within the wedge. It is possible to calibrate a wedge delay only, or a 
wedge delay and velocity at the same time.

To calibrate the Wedge Delay and Velocity

1. Adjust the UT range and gain to see two (2) reflectors.
2. Set the nominal position of the 2 reflectors (in Radius or Depth). Only one 

reflector is required to calibrate the Wedge Delay only.
3. Press Next.
4. If needed, fine-tune the position of the gates to get both signals inside the gates.
5. Move your probe to maximize the signal in gate A.
6. Press Get Position. The software records the peak location. Note that the peak is 

taken on the real signal, not on the envelope.
7. Repeat step 6. on page 168 for the reflector in gate B. Ignore this step to calibrate 

the wedge delay only.
8. Press Accept if the results are satisfactory.
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Table 76  Wedge tab options 

Option Description

Reset Calibration Resets the wedge delay calibration. The “W” at the top of 
the screen disappears.

Clear Envelope Clears the envelope on the bottom view. The green line 
disappears.

Calibrate Calibrates the wedge delay by automatically applying 
beam delays to each focal law so that the reference is seen 
at the same distance for all beams.

Accept Calibration Accepts and saves the wedge delay calibration. The “W” 
at the top of the screen turns green.

Echo Type Depth: Used to set to depth or thickness reflector types, 
herein referred to as the reflector.
Radius: Used to set to radius reflector types, herein 
referred to as the reflector.

Set Depth/Radius A: Used to set the nominal depth of the 
reflector.
Tolerance: Used to set the tolerance.
Depth/Radius 1: In UT, used to set the nominal distance 
of the reflector.
Depth/Radius 2: In UT, used to set the nominal distance 
of the second reflector to get the Velocity and Wedge 
Delay at the same time. Reflector 2 cannot be at the same 
depth as reflector 1.

Gate A Start: Used to set where the gate can start in reference to 
the origin (can be expressed in mm or in.).
Width: Used to set the width of the gate (the bottom 
points red line of the S-scan and the largest of the 
continuous red line on the A-scan).
Threshold: Used to set the height of the gate.
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4.3 TCG/DAC Calibration

The OmniScan X3 flaw detector offers TCG (time-corrected gain). Sizing functions 
enable you evaluate the size of a reflector anywhere in the part by measuring or 
compensating for the signal attenuation. 

For UT and PA channels, it is possible to create a DAC or TCG. The menus for the 
DAC (distance-amplitude correction) calibration are very similar to the menus for the 
TCG calibration. 

To build a DAC instead of a TCG in UT and PA, select the DAC option in the Group 
tab of the calibration wizard (see Figure 4-5 on page 171 and Table 77 on page 171).

A-scan Gain: Used to adjust the signal gain value to get a good 
signal in the gate.
Start: Used to set the start of the displayed A-scans.
Range: Used to set the range of the displayed A-scans.

Previous
Next

Used to alternate between the parameters on the first and 
second pages.

Done Select Done to apply and close the wedge delay 
calibration settings.

Table 76  Wedge tab options (continued)

Option Description
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Figure 4-5  Calibration > TCG

TCG
The time-corrected gain (TCG) function increases the gain applied to the signal as 
a function of the time the echoes take to return. The result is that the echo peaks 
(from same-sized reference flaws) appear at the same screen height, 
independently of their position in the part. The TCG uses the same factors as 
DAC (distance-amplitude correction).

Table 77  TCG tab options 

Option Description

Reset TCG Resets the TCG calibration. The TCG at the top of the 
screen disappears.

Clear Envelope Clears the envelope on the bottom view. The green line 
disappears.

Accept Calibration Accepts and saves the TCG calibration. The TCG at the 
top of the screen turns green.
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Set Section PA TCG calibration can be done in sections. For 
example, some calibration blocks, because of their 
design, can cause unwanted echoes at higher angles, 
from some corner traps or other features. 
By selectively ignoring some angles from a TCG 
calibration, it is possible to build the TCG in two 
separate sequences.
Another practical application of the Set Section could 
be to calibrate at high depth only the lower angles, as 
the high angles are used only for one leg of inspection. 
First Angle: By default, it is the first angle of the group. 
Restricting this angle will gray out the corresponding 
angles in the amplitude chart.
Last Angle: By default, it is the last angle of the group. 
Restricting this angle will gray out the corresponding 
angles in the amplitude chart.
Index Start: Setting this value will gray out and 
exclude the corresponding zone in the amplitude chart 
and S-scan.
Index End: Setting this value will gray out and exclude 
the corresponding zone in the amplitude chart and S-
scan.

UT Settings A-Scan Start: The start of the digitized range for 
calibration.
A-Scan Range: The length of the digitized range for 
calibration.
Ref. Amplitude: The target amplitude for calibration. 
When adding a point, a TCG point will be 
automatically applied so that the amplitude of the 
reference defect is equal to the Ref. Amplitude.
Gain: You can change the gain to bring the amplitude 
higher or lower to facilitate the calibration process.

Table 77  TCG tab options (continued)

Option Description
Chapter 4172



10-001244-01EN, Rev. 13, April 2024
DAC

The distance-amplitude correction (DAC) curve is used to plot the variation in 
amplitude between reflectors of the same size at varying distances from the 
probe. A DAC does not change the gain, but instead sets a reference curve that 

Set Gate A on 
Echo A

Start: Used to set where the gate starts in reference to 
the origin (can be expressed in mm or in.). The origin is 
either the zero of the ultrasound axis or the crossing 
point of gate I if the current signal is synchronized on 
I/.
Width: Used to set the width (length) of the gate.
Threshold: Used to set the height of the gate.

Add Point After manually scanning a reference target over all 
focal laws, selecting Add Point will add a TCG point 
for each focal law. The point will be created at the 
position of the maximum echo in the gate. The Gain for 
each point will be set so that the amplitude for each 
focal law is equal to Ref. Amplitude (see Figure 4-5 on 
page 171).

Undo Last Removes only the last TCG point created. To correct an 
invalid TCG point, remove it before using Add Point 
on the same reflector.

Last Added Points Displays a table of the last added TCG points. There are 
three columns in the table: # (identifier), Range (PA-
only, the First-Last angle used), and Average Depth 
(average of the TCG point position from all focal laws).
This table is a live table; if you leave the TCG tab and 
come back, the table will be cleared. 

Previous
Next

Used to alternate between the parameters on the first 
and second pages.

Done Select Done to apply and close the TCG calibration 
settings.

Table 77  TCG tab options (continued)

Option Description
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varies with distance (for the TCG, the TCG gain applied is set for a constant 
reference level).

It is possible to change from a DAC curve to a TCG curve (and vice versa) by 
selecting either option in the Group tab of the calibration wizard (see Table 78 on 
page 174).

Figure 4-6  Calibration > DAC

Table 78  DAC tab options

Option Description

Reset DAC Resets the DAC curve. The DAC indicator at the top of 
the screen disappears.

Clear Envelope Clears the A-scan envelope.

Add Point After manually scanning a reference target over all 
focal laws, selecting Add Point will add a DAC point 
for each focal law. The point will be created at the 
position of the maximum echo in the gate 
(see Figure 4-6 on page 174).

Undo Last Removes the last added DAC point.
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TFM TCG

Users can set a TCG in TFM Delay-And-Sum (TCG is not relevant for Phase-
Coherence Imaging).

Accept DAC Accepts and saves the DAC calibration. The DAC 
indicator at the top of the screen turns green.

UT Settings A-Scan Start: The start of the digitized range for
calibration.
A-Scan Range: The length of the digitized range for
calibration.
Ref. Amplitude: The reference level. The Reference 
Point level will be at this amplitude, and the first point 
of the DAC is set to this amplitude, using the Auto 
XX % button.
Gain: This can be either adjusted manually or set using 
the Auto XX % button.

Gate A The signal must be in the gate to use the Add Points 
function.
Start: The start of the gate in reference to the origin.
Width: The width of the gate.

Reference Point 
Position

The position of the origin of the DAC curve. You can 
use the Reference Point Position to adjust the initial 
slope of the DAC. A DAC point position cannot be 
before the reference position. By default, the reference 
is set at 0. 

Last Added Points The list of added DAC points. This list is live, so the list 
is cleared if you leave this tab and come back. There are 
2 columns: # (identifier) and Depth (the DAC point 
depth).

Table 78  DAC tab options (continued)

Option Description
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Figure 4-7  TFM TCG interface

Table 79  TFM TCG options 

Option Description

Ref Amplitude Define the amplitude level of calibration.

Gain Sets the initial gain before starting the calibration.

Depth Start/Index 
Start/Depth 
End/Index End

Used to position the gate. A reference reflector must 
pass through the gate to capture the maximum 
amplitude at each position.

Reset TCG Reset the TCG. The TCG indicator at the top of the 
screen is cleared.

Clear Envelope Clears the A-scan envelope.

Add Point Adds a TCG point on the maximum envelope signal 
within the box gate.
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4.4 Manage Points

The Manage Points tab (see Figure 4-8 on page 177 and Table 80 on page 177) is 
used to verify the TCG (or DAC) points value or to manually create or edit TCG 
(or DAC) points, bypassing the calibration wizard.

Figure 4-8  Calibration > Manage Points

Undo Last Removes the last added TCG point.

Accept TCG Accepts and saves the TCG calibration. The TCG 
indicator at the top of the screen turns green.

Table 80  Manage Points tab options 

Option Description

Reset Calibration Resets the TCG calibration. The TCG (or DAC) 
calibration indicator disappears.

Table 79  TFM TCG options (continued)

Option Description
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Clear Envelope Clears the envelope on the bottom view. The green line 
disappears.

Accept Calibration Accepts and saves the TCG (or DAC) calibration. The 
TCG (or DAC) turns green.

Edit Points To create or edit TCG points only for the selected Angle 
(or VPA), use the Current Angle option. To apply TCG 
points for all focal laws at the same time, use the All 
Angles/VPA option.

Angle (PA) When using the Current option, select on which angle 
(VPA) the TCG point will be modified. This option also 
determines which A-scan is seen in the layout.

Add Used to add a TCG (or DAC) point.

Points Used to set the position on the ultrasound axis.

Gain (TCG) Used to set the gain on the point.

Amplitude Used to set the amplitude of the DAC curve at that 
position.

Select Used to select a point. You can then delete it by tapping 
Delete Point.

A % The peak amplitude of the signal detected in gate A.

A^ The depth in the part of the reflector producing the 
indication detected in gate A.

PA^ The distance on the part surface between the wedge (or 
probe) front face and the indication detected in gate A.

SA^ The sound path from the part entry point to the 
indication detected in gate A.

Done Select Accept Calibration to save the Manage Points 
settings, and then select Done.

Table 80  Manage Points tab options (continued)

Option Description
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4.5 DGS Calibration

The distance gain size (DGS) method is used to size reflectors based upon a calculated 
DGS curve for a given transducer, material, and known reflector size.

The main DGS curve represents the signal amplitude of an equivalent flat-bottom 
hole (FBH) reflector of a specified size. The DGS method only requires a single 
reference reflector to create a DGS curve for flaw sizing. This is very different from the 
DAC and TCG methods, which require multiple, representative defects at various 
depths within a part to create a curve for flaw sizing.

All data needed to build a DGS/AVG curve is obtained from the probe and wedge 
information. You can use the DGS calibration wizard to quickly set up and easily 
evaluate flaw size.

To perform a DGS calibration

1. Go to Menu > Plan & Calibrate > Calibration Tools. 
2. On the Group tab, select the desired group, and then click the DGS button.
3. Select the DGS tab.
4. Under Select Reflector, select the type of reference reflector used to build the 

DGS curve: SDH, FBH, K1 IIW, or K2 DSC. (If SDH or FBH is selected, the hole 
diameter must be specified.)

5. Under Set Curves Level, proceed as follows:
a) Select Reg. Level, and then enter the registration level. This value usually 

equals the critical flaw size for the application.
b) Select Delta Vt to set the attenuation of the coupling variation resulting from 

the surface condition of the calibration block and the input part.
c) Select Warning Curves, and then enter the value of the warning curve offset 

(dB) relative to the main DGS curve. Up to three warning curves can be 
added.

6. Under Set Attenuations, proceed as follows:
a) Select Cal. Block Att. to specify the attenuation (dB/mm) for the material of 

the calibration block.
b) Select Specimen Att. to specify the attenuation (dB/mm) for the material of 

the inspected part.
7. This step may be skipped if the sensitivity has already been adjusted. Under Set 

Gate A on Echo A, position the gate on a reference reflector, and then select Auto 
XX%.
Calibration 179



10-001244-01EN, Rev. 13, April 2024
8. Scanning over the reference, build an envelope in the A-scan, and then select 
Calculate DGS.

4.6 TOFD Calibration

This section explains how to calibrate a TOFD group.

4.6.1 WD & PCS

On the TOFD Calibration tab, you can calibrate the TOFD group so that the cursor 
readings are converted to depth instead of time. This is typically done during 
Analysis, but it can be done before. The TOFD calibration has a simplified process and 
is done outside of a calibration wizard. To access the TOFD Calibration options, go to 
Plan & Calibrate > TOFD Calibration (see Figure 4-9 on page 180 and Table 81 on 
page 181). 

With the TOFD Calibration, you can calibrate either:

• The Wedge Delay and PCS (assuming a fixed velocity).
• The Wedge Delay (assuming the PCS and Velocity are correct).
• The Wedge Delay and Velocity (calibrates the wedge delay but validates the 

velocity. This calibration does not apply the velocity).

To perform a TOFD calibration

1. Choose the calibration type (see Figure 4-9 on page 180 and Table 81 on page 181).
2. Define the targets. For Vel & WD and WD & PCS, typically the two targets are 

Target 1= 0 (0 depth as it is the lateral wave) and Target 2 is the material thickness. 
For WD only, use any known reference.

3. Position the Reference Cursor on the first target (lateral wave or other) and the 
Measurement Cursor on the second (back wall echo or other).

4. Select Calibrate.

Figure 4-9  TOFD Calibration — WD & PCS
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4.6.2 Wedge Delay

Select the Wedge Delay calibration type for TOFD to calibrate Wedge Delay only. To 
modify the Type (Wedge Delay), Target 1, Calibrate, and Wedge Delay options, go to 
Plan & Calibrate > TOFD Calibration (see Figure 4-10 on page 182 and Table 82 on 
page 182).

Table 81  TOFD Calibration — WD & PCS type options

Option Description

Type: WD & PCS Wedge delay and probe center separation: Used to 
calibrate, with one wizard, both the delay of the sound 
propagation within the wedge and the distance between 
the exit points of the two probes. Use the correct velocity 
to get an accurate calibration. 

Target 1 Used to set the nominal depth of the first target (a value 
of 0 can be used to target the lateral wave at the surface).

Target 2 Used to set the nominal depth of the second target.

Calibrate Before selecting Calibrate, make sure that both cursors 
are positioned on the echoes corresponding to the 
targets. When both cursors are correctly positioned, the 
Calibrate function will adjust the Wedge Delay and 
PCS values.

Wedge Delay Used to set the delay corresponding to the sound 
propagation within the wedge. This value is 
automatically modified when Calibrate is selected.

PCS Used to set the probe center separation (PCS). This is the 
distance between the exit points of the two probes (only 
available for the TOFD group). This value is 
automatically modified when Calibrate is selected.
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Figure 4-10  TOFD Calibration — Wedge Delay

4.6.3 Encoder Calibration

For the encoder calibration, see “Inspection” on page 187

4.6.4 Velocity and Wedge Delay

To modify the Type (Vel. & WD), Target 1, Target 2, Calibrate, Wedge Delay, and 
Velocity options, go to Plan & Calibrate > TOFD Calibration (see Figure 4-11 on 
page 183 and Table 83 on page 183).

Table 82  TOFD Calibration — Wedge Delay type options

Option Description

Type: Wedge Delay Used to calibrate the delay of the sound propagation 
within the wedge. The PCS and velocity must be 
correct for the calibration to be accurate.

Target 1 Used to set the nominal depth of the first target (a value 
of 0 can be used to target the lateral wave at the 
surface).

Calibrate Before selecting Calibrate, make sure that the reference 
cursor is positioned on the echo corresponding to the 
target. When the cursor is correctly positioned, the 
Calibrate function will adjust the Wedge Delay.

Wedge Delay Used to set the delay corresponding to the sound 
propagation within the wedge. This value is 
automatically modified when Calibrate is selected.
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Figure 4-11  TOFD Calibration — Velocity and Wedge

4.6.5 Lateral Wave Processing

Available only in analysis mode (MXU software and OmniPC software), the Lateral 
Wave Processing option enables you to synchronize sections of the lateral wave and 
remove the lateral wave over a specified interval. To access this option, go to Plan & 
Calibrate > TOFD Calibration (see Figure 4-12 on page 184 and Table 84 on 
page 184).

Table 83  Plan & Calibrate — Velocity and Wedge options 

Option Description

Type: Vel. & WD Velocity and wedge delay: Used to calibrate the delay 
of the sound propagation within the wedge.

Target 1 Used to set the nominal depth of the first target (a value 
of 0 can be used to target the lateral wave at the 
surface).

Target 2 Used to set the distance (expressed in mm or in.) of the 
second target for the calibration.

Calibrate Used to set Target 1 and accept the calibration.

Wedge Delay Used to calibrate the delay corresponding to the sound 
propagation within the wedge. This value is 
automatically set when Calibrate is selected.

Velocity Check Displays the velocity in the material of the inspected 
part after the calibration has been confirmed.
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Figure 4-12  TOFD Calibration —Lateral Wave Processing

Table 84  Plan & Calibrate — Lateral Wave Processing options

Option Description

Lateral Wave 
Processing

Select this type to use the lateral wave synchronization 
and lateral wave removal.

Synchronize Synchronizes a TOFD B-scan, realigning a selected area 
to improve the readability. The zone to synchronize is 
delimited by the cursors in the scan axis, and by the 
gate A in the ultrasound axis. Before selecting 
Synchronize, do these steps:
1-Using the reference and measurement cursors on the 
scan axis in the B-scan, define the width of the section 
to synchronize.
2- Select a reference A-scan using the data cursor. This 
reference is typically a clean A-scan. This A-scan must 
be within the zone delimited by the reference and 
measurement cursors. 
3- Make sure that gate A is active.
4- Position gate A around the lateral wave. The gate 
should be tight enough around the signal, but it must 
capture the lateral wave of all A-scans inside the zone.
5- Select Synchronize.
Multiple zones can be independently synchronized. 
Repeat steps 1 to 5 using another zone.

Reset Synchronize Remove the synchronization of the A-scans within the 
reference and measurement cursors on the scan axis. To 
remove all synchronization, place these cursors at the 
start and end of the full B-scan.
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You must activate gate A to use Lateral Wave Processing. The gate can be active and 
hidden if it is not convenient to keep it displayed. Turn OFF the gates option in View 
to turn off the display of the gate while keeping it active for synchronization.

Remove Removes the lateral wave from the signal to help the 
detection of defects close to the surface. The removal is 
applied to a zone defined by the reference and 
measurement cursors on the scan axis. Multiple 
sections of removed lateral wave can be defined. To use 
the Remove option:
1- Follow the steps to synchronize the lateral wave. 
Lateral Wave Removal can only be performed on data 
that was previously synchronized.
2- Using the reference and measurement cursors on the 
scan axis in the B-scan, define the width of the section 
to remove.
3- Select a reference A-scan using the data cursor. This 
reference is typically a clean A-scan. This A-scan must 
be within the zone delimited by the reference and 
measurement cursors. 
4- Select Remove.

Reset Remove Restores the signal of the A-scans within the reference 
and measurement cursors on the scan axis.

Table 84  Plan & Calibrate — Lateral Wave Processing options (continued)

Option Description

NOTE
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5. Inspection

The OmniScan MXU software interface is designed to be intuitive: you can familiarize 
yourself with its operation by navigating through the interface and testing various 
functions and buttons. For more details, see “OmniScan Interface” on page 27.

The basic inspection parameters are available in the  UT Settings > General 
submenu (see “UT Settings” on page 45).

5.1 Setting the Reference Gain

Auto (80%) reference gain
The suggested, default reference gain value can be selected by tapping the Gain 
area of the screen, and then selecting Auto (80%). This setting adjusts the gain so 
that the reflector signal inside gate A reaches the reference level of 80% of the full-
screen height. Position gate A accordingly before using Auto (80%).

The default reference amplitude value is 80%. To modify this value, select 
 UT Settings > Advanced > Ref. Amplitude, and then enter the new reference 
value.

To set the reference gain

 Select UT Settings > Advanced > Reference dB > ON to activate the reference 
gain.

NOTE
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5.2 Setting Up for an Inspection Using an Encoder

Before setting up for an inspection that uses encoders, an X or XY encoder must be 
properly connected to the I/O connector.

To set up for an inspection using an encoder

1. In the  Scan > Inspection > Type list, choose the type of scan to be used to scan 
the part.

2. Select  Scan > Inspection > Encoders to access the encoder setup screen, and set 
the encoder parameters according to your specifications (see Figure 5-1 on 
page 188). You can use a preset scanner, or edit the parameters for the axis from 
this menu.

Figure 5-1  Scanner Presets selection list

3. If necessary, calibrate the encoder using the Encoder Calibration tool available on 
the right side of the encoder setup screen.

4. Define the area to inspect and the resolution on the  Scan > Area menu.

IMPORTANT
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5. When you are ready to scan, press the Play key ().

5.3 Configuring the Indication Table

The indication table displays detailed information on reflectors identified and 
recorded during an inspection. This information is used to create an inspection report.

To configure the indication table

1. Add an indication to the table by setting your layout and cursors on an indication 
(in Analysis mode) and then tapping Add Indication (see Figure 5-2 on page 189 
on the left). Repeat for every indication you want to add.

Figure 5-2  Indication Table Manager window

2. Tap  File > Indication Table Manager to access the indication table 
(see Figure 5-2 on page 189 on the right and Table 85 on page 190).

3. Move through the list to review indications, add reference numbers and 
comments, and delete indications as required.

① ② ③

④
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Table 85  Indication Table Manager options

Item 
number Description

1 Reference number

2 Comments

3 Delete

4 Scrolling controls
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6. Managing Files, Probes, Wedges, and Reports

Inspection setups and data are kept and organized using files, and presented in 
reports. You can use the  File menu to access multiple file parameters, the Report 
tool, and the File Manager (see Figure 6-1 on page 191).

Figure 6-1  File menu

6.1 Saving, Naming, and Opening Files

It is recommended that you regularly save your setup and data files to prevent 
accidental data loss.
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• To save your setup file, select Save Setup As on the  File menu (see Figure 6-1 
on page 191).

• To name your data file, select Save Data As on the  File menu. You can 
subsequently save the file by pressing the Save key () located just above the 
Power key (). Either option will open the file saving prompt. Enter the base 
name in the field. To save it as is, select the File Increment=None. If you want to 
add a number or a timestamp after the base file name, choose either option. The 
final file name can be seen in the Preview. Finally, if you chose a File increment 
other than None, you can optionally uncheck the Prompt every time to auto-
increment the file after each save without going through this prompt every time 
you press the Save key ().

• To open a file, select Open on the  File menu (see Figure 6-1 on page 191), and 
then choose the directory in which the file is located. You can open the setup file 
or data file by selecting the file type. You can also order the files alphabetically or 
by date using the Filter icon, and preview the selected file (see Figure 6-2 on 
page 192).

Figure 6-2  Open menu

6.2 Using the File Manager

To access various options for managing your files, select File Manager on the  File 
menu (see Figure 6-3 on page 193 and Table 86 on page 193).

File preview area
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Figure 6-3  File Manager window options

Table 86  File Manager options

Item 
number Description

1 Select the source drive: OmniScan X3 hard drive, USB, 
SD card.

2 Select (filter) the desired file type: setup, data, image, report, 
etc.

3 Navigate to folders on the selected drive.

4 File information. In multiselection mode, only the names, the 
file count, and their total size are displayed.

5 Transfer the selected file(s) to a destination of your choice.

6 Rename the selected file. Not available in multiselection mode.

7 Upload to OneDrive or download from OneDrive. See “Using 
OneDrive With the File Manager” on page 195. 

① ②③ ④

⑤
⑥

⑦

⑧

⑨⑩
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To transfer files from an external drive (USB) to the OmniScan X3 unit

1. Insert the USB key (or SD card) in the unit.
2. Select the USB as the source drive.
3. Select the file type to transfer: setup, data, palette, overlay, etc. You can transfer 

multiple files at once if they are the same file type.
4. Navigate the folders and subfolders to find your files. Tap once on a folder name 

to move to that folder. Use the Back button to go back.
5. Tap once on the file you want to transfer, or turn on multiselection, and tap every 

file you want to transfer (this will select the box next to the files).
6. Tap the Transfer button.
7. Make sure you select the OmniScan X3 hard drive as the destination and tap 

Copy to.
8. The files are now available on the unit. Tap Done to exit the File Manager.

To transfer files from the OmniScan X3 unit to an external drive

1. Insert the USB key (or SD card) in the unit.
2. Select the OmniScan X3 drive as the source drive.
3. Select the file type to transfer: setup, data, palette, overlay, etc. You can transfer 

multiple files at once if they are the same file type.
4. Tap once on the file to transfer, or turn on multiselection, and tap every file to 

transfer (this will select the box next to the files)
5. Tap the Transfer button.
6. Select the destination drive (if more than one is available, make sure that the 

correct one is selected).
7. Tap Copy to to transfer the files.

8 Delete one or multiple files.

9 Remaining space on the selected drive. 

10 To transfer or delete multiple files at once, turn Multiselection 
ON.

Table 86  File Manager options (continued)

Item 
number Description
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8. The files are now available on the drive. They are located in the folder olympus_x3 
and sorted in subfolders according to file type.

9. Tap Done to exit the File Manager.

Using OneDrive With the File Manager

To use OneDrive to transfer files to and from the cloud, you must first be connected to 
Internet, then you must be logged in to a OneDrive account. See “Connectivity 
Settings” on page 96. In the File Manager, the OneDrive button is now active 
(see Figure 6-4 on page 196)

Sending Files to OneDrive

Select the file(s) to send to OneDrive and tap Upload to OneDrive. The files are sent 
to the OmniScan X3 Series folder on OneDrive. A green checkmark appears on the 
file, indicating the file is located on the OmniScan X3 hard drive and on the cloud. 

Deleting Files Synched With OneDrive

When deleting a file that is only local on the hard drive, the file is permanently 
destroyed. If the file is uploaded to OneDrive (it has a green checkmark), deleting the 
file only destroy the local copy, and keep the copy on the cloud. A cloud icon appears 
next to the file to indicate that the file only exists in the cloud for now.

Deleting files that are not on the OmniScan X3 (only in OneDrive) is not possible. Use 
a computer to manage the files in OneDrive.

Downloading Files From OneDrive

Any file in the appropriate folder in OneDrive (data files in OmniScan X3 Series/Data, 
setup files inOmniScan X3 Series, etc.) will also appear in the File Manager. If no copy 
of the file exists locally on the OmniScan X3, the file appears with a cloud icon next to 
it. 

To get a copy of this file from OneDrive to the OmniScan X3, simply tap Download 
from OneDrive. The icon next to the file change from the cloud icon to a green 
checkmark, which means a copy of this file is present on OneDrive and on the 
OmniScan X3. 
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If multiple instruments are connected to the same OneDrive account, all of them have 
access to the same files. This can be used to remotely sharing files between 
instruments. One instrument sends a file to OneDrive, and the others can now see it in 
their own File Manager and can download a local copy. 

Synchronizing With OneDrive

If a file is saved OneDrive and locally, but there is a more recent version on one of 
them (if a setup saved in OneDrive is modified in the MXU software for example), the 
option Synchronize OneDrive allows to copy only the most recent copy on both 
OneDrive and the OmniScan X3. A file that is more recent on the OmniScan X3 has an 
arrow up icon next to it, while a more recent file on OneDrive has an arrow down 
icon. 

If a file is corrupted, or no longer exists, an orange triangle icon appears on the file. 
Read the file preview for help on the error.

Figure 6-4  Possible statuses of files in the File Manager

1. A file is on both the OmniScan X3 and OneDrive, but one copy is more recent. 
Synchronize with OneDrive to keep the most recent in both places. 

2.  A file in the OneDrive directory, but not on the OmniScan X3. Download it to get 
a local copy. 

3. A file not yet synchronized with OneDrive. Upload to OneDrive to send a copy to 
the cloud. 

4. A file both in the OmniScan X3 and OneDrive, with the same name and saved 
date.

①

③

④

②
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6.3 Probe & Wedge Manager

Use the Probe & Wedge Manager if you want to create custom probe and wedge 
configurations that are not in the default list provided by Evident (see Figure 6-5 on 
page 197 and Table 87 on page 197).

Figure 6-5  Probe & Wedge Manager window

Table 87  Probe & Wedge Manager window options

Item 
number Description

1 My Probes and My Wedges tabs.

2 Use the Done button to exit the Probe & Wedge Manager window.

3 Section to see a preview of all parameters for the selected probe or 
wedge.

①

③

④⑤⑥

⑦

⑧

⑨

⑩

②
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4 Section to visualize the probe or wedge. A 2-D reconstruction of the 
selected probe or wedge is displayed according to the parameters 
defining this probe or wedge. Wedges can also be displayed in 3D. It 
is possible to change the 3D view by selecting the top cube icons on 
the visualization pane.
The cube icon on the far right enables you to freely rotate and pan the 
3D view and offers more options. To adjust the 3D view, select any of 
the icons in the view, and follow the on-screen instructions. You can 
use the OmniScan X3 knob to adjust each selected view parameter.

5 Use the Edit button to edit the selected probe or wedge. Note: To 
delete a probe or wedge, first click on Edit, and the red “X”, and then 
the Delete button.

6 Use the New From button to create a probe or wedge from an 
existing or standard model. This is a convenient way to create a new 
probe/wedge and save time when entering the parameters.

7 Use the New button to create a probe or wedge from scratch.

Table 87  Probe & Wedge Manager window options (continued)

Item 
number Description
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6.3.1 Nomenclature Information on Probes and Wedges

By default, the OmniScan MXU software establishes the phased array (PA) probe’s 
Reference Point at the position of the first element. To set the Reference Point at the 
front edge of the probe, enter the distance between the front edge of the probe and the 
position of the first element. The value must be negative. To avoid issues with a 
custom probe, make sure that the value of the Reference Point is negative, and that its 
absolute value is equal to Reference point = -1 × (number of elements) × Probe Pitch.

Figure 6-6  PA probe reference point measurement

The wedge’s Reference Point is for the UT group only. It is used to set the probe and 
wedge assembly reference point, which is the distance between the front of the wedge 
and the beam exit point (see Figure 6-7 on page 200). The beam exit point is usually 
marked by a line on the wedge.

8 Lists all available probes and wedges on the local instrument. Select 
any probe or wedge from the list to visualize its parameters or edit it.

9 Use Series to quickly jump to a specific probe series. You can create 
probe series yourself; this can be useful to include probes from other 
manufacturers or custom-made models ordered from Evident.

10 Use Type to filter the different probes or wedges. Only types selected 
are shown and considered.

Table 87  Probe & Wedge Manager window options (continued)

Item 
number Description

1

Front edge of 
the probe

−53 mm
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This value is negative because the OmniScan MXU software establishes the wedge 
Reference Point by default at the beam exit point. To place the Reference Point at the 
front edge of the wedge, you must measure the distance between the front edge of the 
wedge and the beam exit point, and then subtract it from the default 0-reference point 
(UT group only).

Figure 6-7  UT wedge reference point measurement

By default, the OmniScan MXU software establishes the phased array wedge’s 
Primary Offset point at the position of the first element. To set this reference point at 
the front edge of the wedge, in Primary Offset, enter the distance between the front 
edge of the wedge and the position of the first element. The value must be negative 
(see Figure 6-8 on page 200).

Figure 6-8  Primary offset measurement

−2 cm

Front of the wedge

8.0 cm-

Front of the wedge
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A Secondary offset of 0 indicates that the probe is centered on the wedge on the 
secondary axis. If the probe is not centered on the wedge, enter the appropriate value 
(see Figure 6-9 on page 201).

Figure 6-9  Secondary offset

6.3.2 Adding a Probe or Wedge

To add a probe or wedge

 Select the New or New From button. This activates the edit mode. Input all the 
parameters. You need to enter all the parameters correctly to generate an accurate 
visual representation.

6.3.3 Editing a Probe or Wedge

To edit a probe or wedge

 Select the Edit button. This activates the edit mode. You need to enter all the 
parameters correctly to generate an accurate visual representation. This is 
especially important for the wedge representation.

Center of the first 
element (position 0)
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Editing a probe or wedge is facilitated by live indicators displayed on the left. The 
indicators appear for certain parameters when selected. Only variables showing a 
physical dimension can be shown (see Figure 6-10 on page 202 and Figure 6-11 on 
page 203). 

Figure 6-10  Editing a PA Dual probe — Red indicator emphasizing the selected 
parameter
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Figure 6-11  Editing a PA Dual wedge — Red indicator emphasizing the dimension

For PA probes, the element number is displayed. This can ease editing the parameters 
of complex dual PA probes, which can have a variety of wiring and element patterns, 
depending on the probe manufacturers. 

The Element Configuration parameters are used to adjust and confirm the element 
configuration, which is eased by the dynamic live 2D representation (see Figure 6-12 
on page 204).
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Figure 6-12  PA Dual probe advanced parameters — 
Element Configuration parameters

6.3.4 Deleting a Probe or a Wedge

To delete a probe or a wedge

 Select a probe or wedge, click Edit, the red “X”, and then the Delete button.

6.4 Reports

On the  File menu, select Generate Report to configure and print reports using the 
Report Manager (see Figure 6-13 on page 205 and Table 88 on page 205).
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Figure 6-13  Report Manager window

Table 88  Report Manager window options

Item 
number Description

1 Scroll multiple configuration pages.

2 Add your company logo or other images.

3 Edit the fields in this section to configure your report.

4 Report preview section

①

② ③ ④
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7. Total Focusing Method (TFM)

You can set up and use a TFM group on the OmniScan X3 flaw detector.

7.1 TFM Law Configuration

To set up a TFM law configuration

1. Select Main menu > Wizard (Plan & Calibrate) > Scan Plan.
2. Set up the Part & Weld, and the Probes & Wedges.
3. On the Groups tab, select Law Config. > TFM, and complete your desired TFM 

law configuration (see Figure 7-1 on page 208).
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Figure 7-1  TFM on the Groups tab

7.2 Acoustic Influence Map (AIM)

The Acoustic Influence Map (AIM) modeling tool can help you select the correct 
propagation mode (or wave set) for a given flaw. On the OmniScan X3 flaw detector, 
you can use this tool to create a model that represents an amplitude map in the 
material. Each pixel of the AIM represents the theoretical amplitude that could be 
obtained if a reflector was at this position. The map is coded using different colors 
that each represent a specific 3 dB range.

For example, the red color indicates that the ultrasonic response is very good and 
varies between 0 and −3 dB with respect to the maximum amplitude. Orange indicates 
a range from −3 dB to −6 dB, yellow from −6 dB to −9 dB, etc. The maximum 
amplitude for each map is specified with the Sensitivity Index. This value represents 
the maximum sound pressure of the currently selected AIM (the highest amplitude 
pixel). This can help to decide between two propagation modes typically the mode 
with the highest sensitivity index should have a better SNR on the specified reference 
defect. When configuring the AIM model, you can choose either a Spherical 
(volumetric) type flaw, such as porosity, or a Planar type flaw, such as a crack 
(see Figure 7-2 on page 209).

Choose the desired 
inspection mode.

Set the zone to inspect.

Select TFM.
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When you adjust the defect type, the AIM model is automatically updated to show 
the predicted amplitude response of the selected wave set (propagation mode) for 
that flaw. This will help you select the wave set that is best suited for your inspection.

Figure 7-2  AIM Acoustic Influence Map tool

7.3 TFM Settings

After you exit the Scan Plan wizard menu (step 1. on page 207), the TFM settings have 
replaced the UT Settings under the Main menu >  TFM Settings. Figure 7-3 on 
page 209 shows the Advanced parameters under  TFM Settings.

 

Figure 7-3  TFM Settings — Advanced parameters

See “TFM Settings” on page 56 for more information on TFM settings.

Adjust Resolution to change 
TFM image resolution.
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7.4 Phase Coherence Imaging (PCI)

This method is only available on the OmniScan X3 64 model. PCI uses a similar 
algorithm to the standard TFM, but instead of summing amplitude elementary A-
scans, it sums the phase of those elementary A-scans, with the corresponding delays 
at each pixel. Instead of obtaining an amplitude at every pixel, we are acquiring a 
coherence value. Typically, base material without flaws, and long planar reflectors, 
have a low coherence. It is also typical for corners, tips, small reflectors to have a high 
coherence factor.

To toggle between Phase Coherence Imaging and regular Delay-and-Sum, tap on 
Menu > TFM Settings > General > TFM Method.

Figure 7-4  TFM Settings — PCI

Like the Envelope feature, PCI is applied to all TFM groups at the same time.

In a PCI inspection, almost all settings from TFM can be used: Filters, Voltage, Sparse, 
and Resolution. However, Table 89 on page 211 lists the features that are modified.
Chapter 7210



10-001244-01EN, Rev. 13, April 2024
7.5 Plane Wave Imaging (PWI)

Plane Wave Imaging (PWI) is a data collection method, similar to the Full Matrix 
Capture (FMC). 

It is based on plane wave emission at different angles and reception of the associated 
elementary A-Scans.

Delays for summation are calculated using the plane wave propagation at each angle 
and the reception path for each element.

PWI is available on the OmniScan X3 64 with the following settings:

• Linear probe
• Plate or AOD
• TT or LL wave sets
• One group

Table 89  Modified features

Feature Description

Gain The Gain is grayed out, because PCI is an amplitude-
free technique, so adding gain is not relevant. Instead, 
adjusting the color map to interpret what is considered 
relevant is accomplished by adjusting the color palette 
and the zoom-level on the palette. It is also impossible 
to saturate a PCI signal by nature, so subtracting gain 
to remove saturation is pointless.

TCG Calibration TCG is not required to be adjusted on phase. TCG is a 
concept that sets the reference amplitude, but phase 
coherence does not need to be equalized.

Readings Some readings are modified to indicate ʺCoherenceʺ 
rather than ʺ%ʺ or ʺAmplitudeʺ. This is to remind the 
user that TFM in PCI mode is expressed in terms of 
phase coherence rather than amplitude.
Hardness Depth reading is only displayed on 
Omniscan X3 64.
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8. Analysis with the OmniPC Software

In the OmniPC software, you can analyze OmniScan X3 data files. The majority of the 
menus found in the MXU software are present. Although many fields are read-only, 
the interface remains similar to the MXU software.

Start the analysis by using the Open button to select a file to analyze. The OmniPC 
software is organized in tabs:

OmniPC
Includes the same control as the main interface of the MXU software: Gain, VPA 
selector, layout selection, view options. The Zoom key () on the OmniScan X3 
unit is replaced by a zoom button in this tab. It is also possible to use keyboard 
shortcuts instead of the zoom button.

UT Settings
Same as the Main menu >  UT Settings in the MXU software, except that all 
fields are read-only.

Gates
Same as the Main menu > Gates in the MXU software. On this tab, it is possible 
to turn ON/OFF gates and manipulate them. It is not possible to change the gate 
or the A-scan synchronization in post-processing.

Scan
Contains information from the scan. Read-only.

Probe & Part
Same as the Main menu > Probe & Part in the MXU software, but it does not 
include the Probe & Wedge Manager. This tab enables you to edit the probe 
position and the overlay.
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Focal Law
Read-only section containing information on the current group focal law 
configuration.

Measurements
Turns ON/OFF the linked cursors.

Display
Enables you to edit the same parameters as on the Main menu > Display in the 
MXU software. You can also select the Thickness mode from the Display menu 
rather than from the Gate menu in the MXU software.

Preferences
Enables you to change the language and the units (metric/imperial). System and 
legal information are also available to read.

Help
Opens in a new window displaying the list of shortcuts available in the OmniPC 
software. Learning these mouse and keyboard shortcuts can help you increase 
your productivity (see Figure 8-1 on page 215).

You may select View > Scan Plan View to see the scan plan.
TIP
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Figure 8-1  OmniPC Shortcuts Table
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9. Olympus Scientific Cloud (OSC) Connection 

To use the X3 Remote Collaboration Service (X3 RCS), you need to create an account 
on the OSC Platform and your OmniScan X3 unit needs a valid connection to the 
Olympus Scientific Cloud (OSC). 

The unit does not need to be connected to the OSC to download new software 
versions in the OmniScan X3 Launcher (see Figure 1-2 on page 22). To connect to the 
OSC, make sure that the OmniScan X3 unit is connected to the Internet. 

For a step by step procedure, refer to the OSC and X3 RCS Registration Guide 
available on the X3 Remote Collaboration Service page.

To display the OSC connection settings, tap Preferences > Connectivity Settings > 
OSC Connect (see Figure 9-1 on page 218 and Figure 9-2 on page 218)

TIP
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Figure 9-1  Connectivity Settings menu

Figure 9-2  OSC Connect menu
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9.1 OSC Connection Status

Figure 9-3  OSC Connection Status and Registration Status message

• Factory setup
— Indicates whether the factory setup of the instrument was correctly 

configured, meaning that the provisioning process has been completed: 
○ Green means that it was correctly configured in a factory, so the 

provisioning data on the device is coherent and present.
○ Red means that the provisioning data on the device is absent or not 

coherent. 
• Network Connection 

— Indicates whether the OmniScan X3 unit’s wireless or Ethernet network 
connection is properly connected:
○ Green means that your unit is currently connected to a hotspot wireless 

network or Ethernet network connection (connector not available at the 
time of printing).

○ Red means that your unit is not connected to a network.
• Internet Access
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— Indicates that the chosen network connection enables access to the Internet. 
The indicator may be red if the Internet access requires double authentication 
or is protected by a firewall: 
○ Green means the unit has access to the Internet via the chosen network 

connection.
○ Red means the unit does not have access to the Internet via the network 

connection.
• OSC Connection

— Indicates whether the OmniScan X3 unit is successfully connected to the 
server or IOT Hub.
○ Green means that the unit is successfully connected to the IOT Hub with 

the data stored on the device.
○ Red means that the unit failed to connect to IOT Hub with the data stored 

on the device.
• OSC ping

— Indicates whether the OmniScan X3 unit successfully sends and receives 
messages to and from the OSC:
○ Green means that the unit successfully sends and receives messages. 
○ Red means that the unit cannot send and receive messages. 
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9.2 OSC Device Setup

Figure 9-4  OSC Device Setup

• Network Type:
— Indicates whether WiFi or Ethernet is in use (displays green).

○ Red indicates that there is no network connection.
• WiFi Dongle Model (if applicable):

— Name of the USB dongle(s) currently in use. Two or more may be inserted.
— Green indicates that the dongle is officially supported by the OmniScan X3 

unit.
— Red indicates the dongle is not officially supported to use OSC features.

• X3 RCS Availability:
— Indicates whether or not the instrument has access to the X3 Remote 

Collaboration Service (X3 RCS) under its tenant.
• Date Time (MMDDYY):

— Shows the date/time format: dd/mm/yyyy, hh:mm.
• Time Zone:

— Shows the currently selected time zone. 
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9.2.1 Cloud Enable Check Box

When your OmniScan X3 is connected to the Internet, you must check Enable to allow 
the unit to connect to the OSC (see Figure 9-4 on page 221). 

When the Ready and Enable statuses both say Yes, the OmniScan X3 unit is ready to 
connect to the OSC. 

9.2.2 Registration Status

Depending on the Registration Status message (see Figure 9-3 on page 219), follow 
the actions described in Table 90 on page 222.

If there are issues with the connection to the OSC, you can select Unregister on the 
OmniScan X3 unit and also unregister the device on the OSC website (must be done 
by an administrator of the account), and then start the connection process again. 

9.2.3 No Registration Request Found

This message indicates that you must register your OmniScan X3 unit’s serial number 
with your OSC account. The serial number is indicated on the bottom of the 
OmniScan X3 unit. You can also find it by selecting the information () button in the 
bottom-left corner of the OmniScan Launcher. Take note of the number.

Table 90  OSC Connect Registration statuses

Registration status message Action

No registration request found for 
the device. Please register the 
device on the Olympus Scientific 
Cloud.

See “No Registration Request Found” on 
page 222.

Please authenticate the 
registration request by entering 
your 4 digit pin.

Once the OSC provides you with a PIN, 
the status changes in the OmniScan X3 
unit. Enter your four digit PIN and click 
Apply.

Device is successfully registered. When you get this message, the device 
registration is completed. Select Done in 
the upper-right corner to exit the menu.
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To register the unit on the OSC, you need to use a computer with Internet 
access (but keep the OmniScan X3 unit turned on and close by).

○ If you need to create a new account on the OSC, go to www.olympus-
ims.com, and click Cloud Log in to create your account (see Figure 9-5 on 
page 223).

 

Figure 9-5  Cloud Log in

○ If you need to log into a company account, an account administrator must 
send you an email invitation. A company account is used to share X3 RCS 
licenses and keep track of all the registered devices in the company. 

— After you are logged into your OSC account, go to the My Devices section, 
and click Add Device. 

— Enter the OmniScan X3 serial number. Once added, you will be provided a 
PIN. At this point, the Registration Status in the OmniScan X3 unit should 
change (see Table 90 on page 222).
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10. OmniScan X3 Remote Collaboration Service 
(X3 RCS)

The X3 Remote Collaboration Service (X3 RCS) is a subscription-based service 
embedded in the MXU software to save time and costs. This service enables you to 
consult collaborators and get critical support while in the field. Powered by Zoom, the 
service allows: 

• Live screen sharing
• Remote control
• Annotations

If you are in the field, you can also use the X3 RCS with your cell phone to access a 
meeting with the following features:

• Video and audio communication
• Collaborator screen sharing

Licenses for the X3 RCS are shared among users in the same Olympus Scientific 
Cloud (OSC) account. With one license, every user has access to the license, but only 
one can use it at a time. When the meeting is done, the license is released for another 
user. 

For a step by step procedure, refer to the OSC and X3 RCS Registration Guide 
available on the X3 Remote Collaboration Service page. 

TIP
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10.1 Requirements

To use the X3 RCS, you need the following:

• A valid wireless network.
• A valid wireless LAN dongle inserted in the OmniScan X3 unit. The 

recommended model is the LM Technologies LM808-0406 or LM808-0407 
depending on your region. Follow the instructions in the OmniScan X3 userʹs 
manual to know how to insert the wireless dongle.

• The device must be registered on the OSC and synchronized with it.
• The X3 RCS license must be activated in the OSC account by the administrator of 

the account.

iPhone users: When setting up a Personal Hotspot, make sure that the phone’s Device 
Name and Hotspot Password only use alphanumerical characters (letters and 
numbers).

10.2 Activation

The X3 RCS is installed automatically in the MXU software, but is not activated by 
default.

To activate the X3 RCS

1. Contact an Evident sales representative who will provide a PIN for activating the 
X3 RCS license once the device is registered.

2. Create or join an existing account on the OSC (an administrator creates the 
account and invites all other users). Go to www.olympus-ims.com and click 
Cloud Log in as shown in Figure 10-1 on page 227.

NOTE
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Figure 10-1  Cloud Log in

3. All devices that are going to use the X3 RCS must be registered in the account. On 
the OCS, go to the My Devices section and add an OmniScan X3 unit with its 
serial number. When entering the serial number on the OSC, you will get a PIN.

4. Boot the OmniScan X3, make sure it is connected to a wireless network by taping 
the WIRELESS button.

5. Enter the PIN in the OSC CONNECT menu in the OmniScan X3 Launcher. This 
OSC CONNECT PIN is not the same as the X3 RCS license activation PIN.

6. If the PIN is correctly entered, the device should now be registered on the OSC. 
7. In My Apps section in the OSC, the administrator of the account can now add the 

X3 RCS, and activate it with the PIN provided by Evident.

10.3 X3 RCS Statuses

You can access the X3 RCS menu by tapping the RCS icon in the top bar. The RCS icon 
has four color statuses as shown in Figure 10-2 on page 227:

Figure 10-2  X3 RCS four statuses
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Tapping on the RCS icon opens the X3 RCS menu. If the service is available, the first 
thing to do is to tap Start Meeting to create a meeting directly on the OmniScan X3 
unit (see Figure 10-3 on page 228).

Figure 10-3  RCS interface example

While the meeting is started and the OmniScan X3 unit screen is shared, a green 
border is displayed around the screen. 

Table 91  RCS interface description

Interface item Description

Stop Sharing/Share 
Screen

At the beginning of the meeting, the OmniScan X3 
screen is automatically shared to all participants 
invited. Tap this button to stop sharing or to 
resume sharing. It is recommended to stop sharing 
before another collaborator shares its own screen.

QR code Touch the QR code to enlarge it. Scan this code 
with your cell phone to join the meeting. The Zoom 
video application must be installed on your phone. 
Joining with a phone gives additional functions, 
such as audio and video communication and the 
ability to show something to others using the 
phoneʹs camera.

Invite To invite collaborators by email, enter an email 
address, then click on the + button. Repeat this to 
add more participants. When ready, tap Send 
Invite. If you made an error in the address, you 
can delete the address and add the participant 
again. Click Update Invite to send the invitation 
again.

End Meeting When the user ends the meeting, everybody is 
forced out of the meeting.
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10.4 Remote Control

Collaborators can annotate directly on the OmniScan X3 unit screen without 
requesting remote control. 

Collaborators can also ask to remote control the OmniScan X3 unit. A message will 
pop, informing the user that someone is requesting remote control. To give control, 
the user must tap the RCS icon, and click Accept. The participant now has access to 
remote control the instrument. In addition to having access to all the MXU software 
interface, the collaborator can also virtually access the membrane key on the side of 
the OmniScan X3 unit screen (see Figure 10-4 on page 229).

Figure 10-4  OmniScan X3 unit shortcuts

F1

Enter

Escape

Left Alt + F1

Left Alt + F7

Left Alt + F8

Left Ctrl + D
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You can only request Remote Control from Zoom on a PC. Cell phones and tablets do 
not have access, but this is a limitation of the Zoom video application that is used to 
communicate with the OmniScan X3 unit, rather than a X3 RCS limitation. 

10.5 Zoom Application

Zoom (www.zoom.us) is an application that can be installed on a cell phone, tablet, or 
PC. You can also use Zoom in a web browser. You can use all the zoom versions to join 
a meeting with the OmniScan X3 unit. 

Some devices have more restrictions, for example it is not possible to remote control 
the OmniScan X3 unit from a cell phone.

From Zoom, you can:

• Join a meeting from the OmniScan X3 unit.
• Share audio and video with other participants (the user must use another device 

as audio and video are not active on the OmniScan X3 unit).
• Invite other participants. It can be easier to type email addresses from a laptop 

than from the OmniScan X3 unit touchscreen.
• Edit participant settings.
• Annotate the OmniScan X3 unit screen.
• Send reactions.
• Chat with other participants (not seen on the OmniScan X3 unit screen).
• Request remote control.

Invite Others From the Application

To invite other participants from Zoom, the user must first join the meeting created by 
the OmniScan X3 unit. Then, click Participant, and then click Invite. You can now 
share the invitation to this meeting with others (see Figure 10-5 on page 231).

NOTE
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Figure 10-5  Invite other participant from the Zoom application

10.6 Typical Workflow

Once connected to Internet and the RCS application activated, the OmniScan X3 user 
can request help from collaborators. 

To request help

1. Tap the RCS icon.
2. Click Start Meeting.
3. Tap Invite.
4. Add the email address, then click on +.
5. If needed, repeat step 4 for each participant to invite. When done, tap Send 

Invite.
6. Tap the QR code to enlarge it and scan it with your cell phone to get a link to join 

the meeting.
7. Wait for everyone to join the meeting. The OmniScan X3 user can use video and 

audio from their cell phone.
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8. If a participant requests control, tap the RCS icon to give control.
9. When done, click End Meeting to leave and close the meeting. The RCS license 

can now be used by another OmniScan X3 user in the same OSC account.
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